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DriveRight FMS Help 

Welcome to DriveRight Fleet Management Software 

Click on the topics below for help using DriveRight® Fleet Management Software (FMS) version 
3.5: 
 
Getting Started - How to get your DriveRight software rolling. 
Quick Reference - Basic info and quick links for routine tasks. 
Menu Commands - Everything you can do in DriveRight FMS. 
Troubleshooting - Help when you have problems. 
 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
January 30, 2006 

Getting Started 

Getting Started Menu 

The following help topics will help you getting started with DriveRight Fleet Management 
Software. 
 

Introduction to FMS 

What's New for DriveRight FMS 3.5 
Release Notes for Versions 3.4, 3.3, 3.2, 3.1, and 3.0 

Architecture 

Database Selection Guidelines 

Converting VMS 2.04-2.06 Data for FMS 

 

Setup Overview 

Tool Bar 

 
Back to Home 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Introduction to DriveRight FMS 

The DriveRight Fleet Management Software (FMS) allows you to store, view, and manipulate 
DriveRight data on your Windows-compatible computer. More specifically, FMS provides tools for 
sorting, tracking, analyzing and printing data, and viewing and printing reports for a number of 
individual DriveRight consoles at a number of different locations.  
 
DriveRight FMS features include: 

• Tracking drivers, vehicles, locations, and service 
• Viewing, graphing, printing and saving "accident log" information 

• Multiple user levels  

• Tamper logs 

• Sorting data and creating reports according to user-defined selection criteria 

• Summarize data by day and by trip 

• Integrated Microsoft MapPoint support for mapping of GPS data 

• Compare vehicles, drivers, or groups of drivers 

• FTP Export / FTP Import data 
• Palm download support 

 
See also: 
 

Architecture 
Copyrights 

 
Back to Getting Started 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Architecture 

DriveRight Fleet Management Software (FMS) architecture allows the software to be connected 
to any of the Database Servers we support. The communication between DriveRight FMS and 
Database is done through an OBDC connection by means of an OBDC driver. Currently 
DriveRight FMS supports MS Access, My SQL, MSDE, SQL Server and Oracle databases. Other 
databases may be added in the future. 
The following figure illustrates how DriveRight FMS connects to the back-end Database Server. 
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Note: DriveRight can only be connected to one database at a time. 

When DriveRight FMS is opened for the first time, the user is prompted to select the database 
type to be used for this installation. Based on the user's selection, a connection is established to 
one of the OBDC drivers. The database type is stored in the configuration file. 
 
See also: 
Database Selection Guidelines 
Setup Overview 
 
 
Back to Getting Started 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Database Selection Guidelines 

Please refer to the DriveRight FMS Database Selection Guide for information on choosing and 
installing a database for your installation. We included a printed copy of the Database Selection 
Guide with your DriveRight FMS as well as a PDF version that can be found in the DriveRight 
FMS program folder. The Database Selection Guide can also be downloaded from the 
Automotive Support section of our website:  DriveRight FMS Database Selection Guide. 
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DriveRight Fleet Management Software (FMS) supports the following databases. 

Single-User Databases: 

o MS Access (Microsoft Access) 
o MSDE (Microsoft Desktop/Data Engine) 

Multi-User Databases: 

o MySQL 
o MS SQL Server (Microsoft SQL Server) 
o Oracle  

Note:  

See also: 

Architecture 
Setup Overview 

Back to Getting Started 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Converting 2.04-2.06/2.6.1 Database to DriveRight FMS Format 

A separate conversion utility, OldToNew, has been included with the DriveRight FMS software to 
allow the conversion of existing DriveRight 2.04, 2.05, 2.06 and 2.6.1 database files for use with 
DriveRight FMS. 

Note: This conversion utility can only be used with databases created by DriveRight 2.04, 2.05, 
2.06 or 2.6.1. If you are using an earlier version of the DriveRight software you must first upgrade 
to one of the supported versions. 

Use the following procedure to convert your existing DriveRight database for use with DriveRight 
FMS: 

1. Install and run DriveRight FMS before you convert your data to the new format.   
2. Verify the current location in DriveRight FMS using the Current Location command in the 

Setup Menu. This location information will be associated with all the 2.x data when 
converted into the new database format.  

 

3. To import data to a new location, select the Company Locations command in the 
Database Menu in DriveRight FMS, then click the Add New button in the Company Locations 
browse window.  
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4. Go to Startup>Programs>DriveRight and run OldToNew. 
5. To import data, select the location from the drop down list. 

 

6. Click the Browse button to select the DriveRight 2.x tables directory (By default it is 
C:\Program Files\DriveRight Software\tables).  
7. Click the Convert button to start the conversion. Once the data is converted you will see a 
success message. 

Note: The conversion process can take a long time depending on the size of your 2.x database. 
You can interrupt the conversion at any time by clicking the stop button, but this is not 
recommended. 

8. All the 2.x data has been converted into the new database format for DriveRight FMS. 
9. Go to DriveRight FMS and view various tables using the Database Menu commands to 
make sure the data has been converted properly. 
 
Back to Getting Started 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Setup Overview 

The initial setup of your DriveRight FMS consists of the following operations: 

1. Select and Install Database  

Before you run the software for the very first time you will need to select the database to be used 
with DriveRight FMS. Refer to the Database Selection Guide for information on choosing and 
installing a database.  
If you select either MS Access or MSDE, DriveRight FMS will install the necessary components 
during the FMS installation. If you select MySQL, MS SQL Server, or Oracle, you will need to 
install and configure the database before installing DriveRight FMS. 

Database Selection Guidelines 

2. Install DriveRight FMS 

Insert the DriveRight FMS CD and follow instructions. 

3. Initial Program Configuration when you first run DriveRight FMS. 

Refer to the DriveRight FMS Getting Started Guide for initial program configuration information. 

4. Converting DriveRight 2.04, 2.05 & 2.06 Databases 

If you have a DriveRight database created using version 2.04, 2.05, or 2.06 of the DriveRight 
Vehicle Management Software, it needs to be converted for use with DriveRight FMS: 

Convert Database 

5. DriveRight FMS Software Setup 

Check the following configuration preferences and make any necessary changes: 
Set Units - Select your unit preferences for the data displayed in the dialog boxes, 
database browser, and reports. 
Automation Options - If this option is set, you will be prompted to backup data at the 
intervals specified, and also can set the amount of data to keep in the current database. 
Download Options - Use this option to synchronize the DriveRight device date and time 
with your computer after each download. Also, if a downloaded device is either a 500 or 
600 model, you can choose how the software will treat the Driver ID. Once set, this 
preference will be uniform for all devices. 

6. Set Default DriveRight Settings Wizard 

The values entered in this setup are used as default settings when you add new DriveRight 
devices to the database. You can set DriveRight default values using the Default DriveRight 
Settings Wizard in the Setup Menu. Check the default settings to make sure they suit your 
application. 

7. Set Default CarChip Settings 
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The values entered in this setup are used as default settings when you add new CarChip devices 
to the database. You can set CarChip default values using the Default CarChip Settings 
command in the Setup Menu. Check the default settings to make sure they suit your application. 

Note: If you are using both DriveRight and CarChip devices in your fleet, be sure to set the Safety 
Settings uniformly for both types of devices.  

8. Select the Serial Port and Test Communications 

o Use the Serial Port - DriveRight command in the Setup Menu to select the serial port 
used to connect to a DriveRight device.  

o Use the Serial Port - CarChip command in the Setup Menu to select the serial port used 
to connect to a CarChip device.  

o Use the Auto Detect feature in the Serial Port dialog box to test communications. 

9. CarChip / DriveRight Considerations 

o If both a CarChip device and DriveRight console are installed in the same vehicle, you 
will need to create duplicate entries in the DriveRight FMS databases for the vehicle and 
driver. Otherwise you will see duplicate trip data in your DriveRight FMS reports. 

o If you have multiple serial ports, you can connect CarChip to one serial port and 
DriveRight to another. If you do not have multiple serial ports we recommend you buy a 
serial switch box to switch between the two devices or a serial extension cord to make 
plugging and unplugging the download cables more convenient. 

10. Building Your Database Tables 

• When you add a DriveRight you will need to assign a default vehicle. When you add a 
vehicle you will need to assign a default driver. So, it is most efficient to add the drivers 
first, the vehicles second and the DriveRights third. 

o First, add all drivers. 
o Second, add all vehicles. 
o Third, add all DriveRights. 

o When you add a CarChip you will need to assign it to either a vehicle or a driver. If you 
assign CarChip to a vehicle, all the downloaded data is assigned to the default driver of 
that vehicle. If you assign CarChip to a driver, all the downloaded data is assigned to that 
driver and the vehicle will be unallocated. 

o If a CarChip will only be used in one vehicle, assign it to that vehicle. 
o If a CarChip will be used by only one driver, assign it to that driver. A CarChip 

assigned to a driver can be used in multiple vehicles. 

11. Using the Software 

You are now ready to start using DriveRight FMS. 
 
 
 
Back to Getting Started 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Tool Bar 

To get information about an FMS menu command or tool bar icon, click on the command or icon 
in the illustration: 
 

 

 

List of Toolbar Icons 

Database Icons 

 View Trips Database 

View DriveRight Database 

View CarChip Database 

View Drivers Database 

View Vehicles Database 

Add Device Icons 

Add New DriveRight Wizard 

Add New CarChip Wizard 

Report Icons 

Driver Performance Score Report 

Trip Summary Report 

Usage Report 
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Odometer Report 

Accident Log Report 

File Menu Command Icons 

Print 

Print Preview 

Clear Screen 

Data Download/Export Icons 

Download DriveRight 

Download CarChip 

Download Palm 

Export GPS Data to Mapping Software 

Help Icon 

Help Topics 
 
Back to Getting Started 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Quick Reference 

FMS Quick Reference 

Get More Information About: 

Data Management  
CarChip  
DriveRight 
Mapping 
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Back to Home 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Data Management 

Data Management Reference Menu 

Database Backup Considerations 
Active Database Size Recommendations 
Backup 
Restore 
Export Menu 
Import Menu 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
 

Database Backup Considerations 

If you have GPS-enabled DriveRights, you will rapidly accumulate a large amount of data in the 
GPS Table due to the frequency of GPS logging. 
To avoid the database from becoming unmanageable, you can export the GPS Table alone more 
frequently than your normal backup interval, and delete the GPS data by using the Maintenance 
command. By doing this you still have trips data for your reports while at the same time limiting 
the database size.  
 
Example:  

1. Set the Automation Option (Preferences command in the Setup Menu) to backup every 
two (2) months and keep last three (3) months active in the database.  

2. Suppose that you have some DriveRights with GPS data enabled. Your GPS Table will 
grow much more rapidly than the Trips Table. But you still want to keep the last three (3) 
months of trip data for reporting purposes. 

3. Since DriveRight FMS does not support Backup of individual database tables, you can 
use the Export command to create individual backups of the GPS Table.  

4. Refer to the Database Size Recommendations Table to determine how frequently you 
should Export the GPS Table. Once you determine the export frequency, you will need to 
manually repeat this process.  

5. In this example, you want to keep one month of GPS data active in the database. 
6. Go to the Export GPS command.  
7. Enter a file name for the GPS export data similar to this: gps_10_apr_2003.txt. 

Note: Be careful about naming the GPS export file so that you don't lose previously exported 
data. 
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9. Go to the Database > Maintenance > GPS command and delete all GPS data older than 
your export frequency from Step 5. In this example it is one month. 
 
See also: 
Active Database Size Recommendations 
Preferences: Automation Options 
Export Menu 
Maintenance 
 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Active Database Size Recommendations 

The following recommendations are based on tests and calculations made with these 
assumptions: 

o 10 trips per day per vehicle 
o Trip duration: 1 hour (10 hours driving time per day per vehicle) 
o GPS data logged every 10 seconds 

Note: If your fleet size exceeds the scenarios shown below, we recommend that you use a multi-
user database. 

Note: For multi-user databases, theoretically there is no fleet size limit. Still, we recommend that 
you backup data once a month, keeping only the amount of data required for reporting purposes 
in the active database, typically 3-6 months. 

Recommendations Table 

Scenario  Number 
of  
Vehicles  

Amount of Active 
Data in  
Database  

Remarks and Recommendations 

25  Up to 1 year  Backup data once a month for application 
performance. Using automation options you can 
set maximum of 1 year of data in the active 
database 

50  Up to 9 months  
 

Backup data once a month for application 
performance. Using automation options you can 
set maximum of 9 months of data in the active 
database 

No GPS  

100  Up to 6 months  Backup data once a month for application 
performance. Using automation options you can 
set maximum of 6 months of data in the active 
database 
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MSDE 
with GPS  

5  Up to 1 month  Backup data every month for application 
performance. Using automation options you can 
set maximum of 1 months of data in the active 
database 

MS 
Access 
with GPS  

10  Up to 1 month  Backup data every month for application 
performance. Using automation options you can 
set maximum of 1 months of data in the active 
database 

 
 
See also: 
Active Database Size Recommendations 
Preferences: Automation Options 
 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Backup 

The Backup feature is used to archive old data as a zip file. The backup files are stored in the 
Backup sub-directory in the DriveRight FMS install directory. The Backup sub-directory is created 
the first time you back up your data.  
The backup zip files are named based on the start and end dates chosen for the backup. For 
example, if you pick the dates between March 6, 2003 and March 27, 2003, the backup file will be 
named 6March2003_27March2003.zip. 
You can configure how much data to keep active after a backup by setting up your Automation 
Option preferences in the Setup menu. Limiting the amount of data in the active database helps 
prevent the database from growing into an unmanageable size. 
 
To backup data: 

1. Click Backup in the File menu. The Backup Files To dialog box is displayed. 
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2. From the Backup Files To dialog box select the folder where the backup file will be 
written. The Backup Options dialog box is displayed.  

Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight 
data. 

 

3. In the Backup Options dialog box check your last backup date and specify whether to 
backup the whole database or only those records falling within a specified time period. The start 
date will always be initialized to the last backup date. 
4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up 
your database. 
5. When the backup is finished, click OK to return to the program. 
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See Also: 
Restore 
Preferences: Automation Options 
 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Restore 

The Restore command is used to get a previously Backed up data back into the active database. 
In this process you can pick one or more tables to be restored. 
 
To restore data: 

1. Click Restore in the File menu. The Restore Files From dialog box is displayed. 

 

2. From the Restored Files From dialog box select a single zip file to restore, and then click 
the Restore button. DriveRight FMS unzips the file and displays all the tables in the dialog, and 
displays the following dialog box: 
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Note: You can only restore one zip file at a time. 

Note: The backup file filename is based on the start and end dates chosen for the backup. 

3. You can either restore all the database tables or restore individual database tables. Click 
Yes in the dialog box to restore all the tables. Click No to restore selected database tables. 
4. If you are restoring selected database tables, select each table to be restored. Hold down 
the Control key on your keyboard to select multiple tables. When you have finished making your 
selection, click Restore to restore the tables or click Cancel to exit without restoring the tables.  

 

5. When the files have been restored, click OK to return to the program. 
 
See Also: 

Backup 
 
 
Back to File Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
   

Export Menu 

Use the export menu options to export DriveRight FMS data. 
 
FTP Export - Use the FTP Export command to export database data to a remote site. 
Export GPS to Mapping Software - Use the Export GPS to Mapping Software command to export 
GPS data in a format designed to be imported into mapping software. 
Export Accidents to Mapping Software - Use the Export Accidents to Mapping Software command 
to export accident GPS data in a format designed to be imported into mapping software. 
Other Export Commands - Use the other export commands to export the indicated type of data in 
a tab-delimited text file. 
 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Import Menu 

Use the Import Menu options to import DriveRight database data into DriveRight. 
 
Import: FTP Import 
Import: Import Data From 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

CarChip Quick Reference 

CarChip Quick Reference 

CarChip Considerations 
Adding Drivers, Vehicles and CarChips 
CarChip Considerations 
CarChip Settings 
Downloading CarChip 
Downloading CarChip Guidelines 
Download CarChip 
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Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Adding Drivers, Vehicles and CarChips 

Please refer to the following guidelines when adding new drivers, vehicles, and CarChips 
devices. 
 

• A CarChip device must be assigned to either a vehicle or a driver. 

• Unlike DriveRight devices, a CarChip device can be easily switched from vehicle to 
vehicle, as long as all the vehicles provide a supported OBDII port. 

• If a CarChip is assigned to a vehicle, the default driver of that vehicle will appear as the 
driver on all downloaded data from that CarChip. 

• If a CarChip is assigned to a driver, then all data downloaded from that CarChip will be 
associated with that driver and the vehicle will be listed as UNKNOWN VEHICLE.  

• If you just want to add a CarChip and you don’t yet have a vehicle or driver to assign, you 
can select "UNKNOWN VEHICLE". 

• Based on your specific situation, you should carefully consider the options before 
assigning a CarChip to either a vehicle or driver. 

• The Add New CarChip command opens a wizard that will guide you through the process 
of adding CarChips. It will also allow you to add drivers and vehicles if they are not 
already in the database. 

 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

CarChip Considerations 

o If both a CarChip device and DriveRight console are installed in the same vehicle, you 
will need to create two entries for the driver and two entries for the vehicle in the 
DriveRight FMS database. Otherwise you will see duplicate trip data in your DriveRight 
FMS reports. 

o If you have multiple serial ports, you can connect CarChip to one serial port and 
DriveRight to another. If you do not have multiple serial ports we recommend you buy a 
serial switch box to switch between the two devices or a serial extension cord to make 
plugging and unplugging the download cables more convenient. 

o If you are using both CarChip and DriveRight devices, make sure both types of devices 
use the same safety settings.  

• Speed Band 3 in CarChip should match Speed Limit in DriveRight. 

• Hard Braking in CarChip should match Decel Limit in DriveRight. 

• Hard Acceleration in CarChip should match Accel Limit in DriveRight. 
o Unlike DriveRight, a CarChip can be assigned either to a vehicle or to a driver.  
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Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

CarChip Settings 

Use the CarChip Settings command in the CarChip Menu to quickly view all CarChip settings, to 
add a CarChip to the database or to edit CarChip settings. 
 

1. Select CarChip Settings from the CarChip Menu. The CarChip Device Settings dialog box 
is displayed. 

 

2. Make any desired changes. For more information on the CarChip settings, click on the 
links below: 

CarChip ID 
Hard Braking, Acceleration and Speed Bands 
Choose Parameters 
Miscellaneous Settings 

Note: If you change the vehicle assigned to a CarChip, the vehicle table will also be changed to 
reflect the new assignment. 

Note: If you assign a vehicle to a CarChip that had been previously assigned to a DriveRight 
device, the vehicle assignment for that DriveRight will be changed to "UNASSIGNED VEHICLE". 

3. If necessary, click Defaults to change the CarChip Hard Braking, Acceleration, Speed 
Bands, and Engine Parameters to the DriveRight FMS CarChip default settings. 
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4. Click OK to save the changes or click Cancel to exit without saving. 
 
 
Back to  CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Downloading CarChip Guidelines 

You cannot download a CarChip device if any of the following conditions exist: 

• CarChip not present in the database. 

• CarChip not assigned to a Vehicle or to a Driver. 

• Unless every thing is configured properly, you cannot download from the device. 
 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download CarChip 

Use this command to download data from your CarChip data logger into your computer. 
 
To download CarChip data: 

1. Connect your CarChip device to your computer. 
2. Choose Download CarChip from the CarChip menu. The Downloading Data dialog box 

appears. 

 

2. The dialog box disappears when the download is complete. 
3. Choose Cancel only if you wish to abort the download before it is finished. 
 
See also: 
Downloading CarChip Guidelines 
 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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DriveRight Quick Reference 

DriveRight Quick Reference 

DriveRight Configuration 
Adding Drivers, Vehicles and DriveRights 
DriveRight Settings 
Verify DriveRight Calibration 
Setup GPS 
Downloading DriveRight 
Downloading Requirements 
Download DriveRight 
Download Palm 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Adding Drivers, Vehicles and DriveRights 

Please refer to the following guidelines when adding new drivers, vehicles, and DriveRight 
devices. 

• The Add New DriveRight command opens a wizard that will guide you through the 
process of adding DriveRights. It will also allow you to add drivers and vehicles if they are 
not already in the database. 

• If you are adding a new driver, vehicle, and DriveRight, you should add the driver first, 
the vehicle second, and the DriveRight last. 

• If you just want to add a vehicle and you don’t yet have a driver to assign, you can select 
"UNALLOCATED DRIVER". 

• If you just want to add a DriveRight and you don’t yet have a vehicle to assign, you can 
select "UNKNOWN VEHICLE". 

Important: If you selected either a UNALLOCATED DRIVER or UNKNOWN VEHICLE, you 
should change them to real entries before actually using the DriveRight in the field and 
downloading it. Otherwise, the data will be assigned to the wrong entities and will affect the 
results when you run Reports, etc. 

 
See also: 
Add New DriveRight 
 
Back to Quick Reference Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings 

The following commands allow you to view and or change the settings on a DriveRight device: 
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View/Set 
Restore 
Setup GPS 
Verify DriveRight Calibration 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

DriveRight Settings: Verify DriveRight Calibration 

The Calibrate DriveRight dialog box allows you to verify DriveRight calibration settings. 
o The Calibration Setting Dialog box shows two installation methods. VSS (vehicle 

speed sensor) installation and Reed Switch.  
 
To verify the  DriveRight console calibration: 
 

1. Click on DriveRight Settings from the DriveRight Menu. 
2. Select Verify DriveRight Calibration from the drop-down menu. A DriveRight Calibration 

Message dialog box is displayed. 
3. Click OK, Set or Cancel to continue, depending on the displayed message. The Calibrate 

DriveRight dialog box is displayed. 

 

3. If the DriveRight is using a reed switch for the speed sensor, make sure the Installation 
Method indicates Reed Switch. 

o Reed Switch: If the DriveRight device has been previously calibrated in the 
vehicle or through the software, then DriveRight FMS automatically calculates 
the Calibration number for your vehicle. We strongly recommend that you do not 
change these values. The PPR for a reed switch is always “1”. 
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4. If the DriveRight is using the vehicle's VSS for the speed sensor, make sure the 
Installation Method indicates VSS. 

o VSS: If the DriveRight device has been previously calibrated in the vehicle or 
through the software, then DriveRight FMS automatically calculates the VSS 
PPM (Pulses Per Mile), PPR (pulses per reading) and Calibration number for 
your vehicle. Otherwise you must specify the PPM for your vehicle. Depending 
on your selection, software calculates the PPR (pulses per reading) and 
calibration values and fills the edit boxes with them. 

5. If you are using the VSS, you can adjust the pulses per mile (PPM) from the drop down 
list or enter the PPM in the edit box if necessary. We recommend that you not change these 
settings if the DriveRight has been previously calibrated.  
6. Click OK to save changes to the calibration, or click cancel to exit without saving 
changes. 
 
 
Back to DriveRight Menu | DriveRight Settings 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings: Setup GPS 

Use this command to view and/or modify the GPS settings on a DriveRight device. 

Note: This command only works with the DriveRight 600. 

 
To setup GPS logging: 

1. Select DriveRight Settings from the DriveRight Menu. 
2. Select Setup GPS from the DriveRight Settings drop down list. The Setup GPS Logging 

Interval dialog box is displayed. 

 

3. Set GPS Logging to On, Off, or DriveRight Speed Only. 
o Select On to enable GPS logging. 
o Select Off to disable GPS logging. 
o Select DriveRight Speed Only to log the DriveRight speed without the GPS 

coordinates. No GPS unit is required to enable this option. 
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4. Enter the desired logging interval and indicate a time unit of either seconds (Sec) or 
minutes (Min). Logging Hours indicates how much data can be stored at the selected interval. 
5. Click Set to save the changes or click Cancel to exit without changing the settings 
 
 
Back to DriveRight Menu | DriveRight Settings 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Downloading Requirements 

You cannot download a DriveRight if any of the following conditions exist: 

• DriveRight not present in the database. 

• DriveRight not assigned to a Vehicle. 

Note: The same conditions also apply to Host Mode and Palm Download. 

Back to Quick Reference Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download DriveRight 

The Download DriveRight command transfers trip data from the connected DriveRight device to 
the DriveRight database.  
 
To download your DriveRight: 
 

1. Connect your DriveRight console to your computer and make sure the DriveRight is 
"awake". Press the MODE key if there is nothing on the LCD display. 

2. Select Download DriveRight in the DriveRight Menu. The following Download Status box 
is displayed: 

Note: You will see the Cancel button only if you are downloading a DriveRight 600. 
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3. You may lose GPS data for earlier trips if the DriveRight console is not downloaded for 
an extended period of time. In this case you will see a warning message similar to this: 

 

4. If the calibration in the DriveRight console does not match the calibration in the database, 
you will see a warning message similar to this: 

 

5. When the data has finished downloading the following dialog box is displayed: 
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6. Press Enter or click OK to continue. 
 
See also: 
Downloading DriveRight Guidelines 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Download Palm 

DriveRight 3.0 offers a new feature to download data from multiple DriveRight devices from a 
Palm device. You will need the DriveRight Palm Download Kit, #8181, in order to use this 
command. 

Note: To download a DriveRight console data into the software using Palm Download, the 
DriveRight should be present in the database. If you try to download a DriveRight which is not 
present in the database, you will get an error message.  

 
To download your Palm: 

1. Select Download Palm in the DriveRight Menu.  
2. The first time you download a Palm, the following dialog box is displayed. Select the 

directory which contains your Palm backup databases and click OK. 
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3. Each time after the first time, when you use the Download Palm command, the following 
dialog box appears showing the selected Palm backup directory.  

 

4. Click Browse to select a different backup directory, click OK to use this displayed 
directory, or click Cancel to exit. 
5. If you click OK the Download Status dialog box is displayed.  
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6. When the data has finished downloading the Palm Download, Download Successful 
dialog box is displayed: 

 

7. Click OK to continue. 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Database Menu 

Use the Database Menu options to open individual database tables. In the database table you 
can view and print records. You can also add, edit or delete records. 

Caution: Take extra care before deleting Company Location, DriveRight, CarChip, Driver or 
Vehicle records. 

The following Database Menu options are available: 
 
Company Locations 
DriveRights 
CarChips  
Driver Groups 
Drivers 
Fleets 
Vehicles 
Trips 
Accident Logs 
Tamper Logs 
Trip Addresses 
Days 
Download Dates 
GPS 
Odometer Logs 
Safety Score 
Trouble Codes 
Readiness Codes 



Printed Documentation 

28 

 
Maintenance 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Reports Menu 

DriveRight can produce a number of useful reports. The reports can be displayed on the screen 
or printed. 
 
The following reports are available: 
 
Accident Log Report 
Driver Safety Score 
Driver Safety Score Summary 
Exception Reports 
Database Reports 
Usage Report 
Trip Summary Report 
Tamper Logs Report 
Odometer Report 
Relationship Report 
Days Since Last Download 
 
 
Back to Menu Commands Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Mapping Quick Reference Menu 

Mapping Quick Reference Menu 

The integrated MapPoint ActiveX control in DriveRight FMS allows you to easily generate maps 
from DriveRight GPS data. DriveRight FMS can also export GPS data in a tab-delimited file for 
use by third-party mapping software. 

How to Create Maps 
How to View Maps 
Mapping Menu 
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DriveRight FMS Mapping Requirements 

Back to FMS Quick Reference Menu | Mapping Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 
 
 

How to Create Maps 

How to Create Maps 
DriveRight FMS can create three different maps from your GPS data. You can also export GPS 
data for use in third-party mapping software such as MS MapPoint. 
 
Creating a Trip Map 
Creating a Day Map 
Creating an Accident Log Map 
Export: GPS to Mapping Software 
Export: Accidents to Mapping Software 
Import GPS Data Into MapPoint 
 
Back to  FMS Quick Reference | Mapping Quick Reference 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Creating a Trip Map 
Click the Map button the Trips browse window to create a map from a trip record.  

To create a Trip Map: 

1. Select the Trips command in the Database menu. The Filter For Trips dialog box is 
displayed. 

2. Select your desired Trips filter options.  
3. Click OK to show the Trips browse window. 
4. Highlight a trip record then click Map to generate a Trip Mapping Report for that trip. 
  The map is displayed in the DriveRight FMS program window. 

See also: 

Viewing Trip Maps 
Map Navigation 
Viewing GPS Plot Information 

Back to Mapping Overview  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 



Printed Documentation 

30 

 
Creating a Day Map 
Click the Map button the Days browse window to create a map for all trips taken on the same 
day. 

To create a Day Map: 

1. Click Days in the Database menu. The Filter for Days is displayed. 
2. Select your desired filter options.  
3. Click OK to show the Days browse window. 

2. Click Map to generate the Day Mapping Report. The report is displayed in the DriveRight 
FMS program window. 
 
See also: 
Viewing Day Maps 
Map Navigation 
 
Back to Mapping Overview  
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Creating an Accident Log Map 
You can create an Accident Log Report Map by selecting the Output to: Map or Output to: Both 
Map and Excel options when you create the Accident Log Report.  

To create a Accident Log Map: 

1. Select the Accident Log command in the Reports menu. The Filter for Accident Logs is 
displayed. 

2. Select the desired Accident Log filter options, being sure to select Map or Both Map and 
Excel for the report output. 

3. Click OK to create the Accident Log Mapping Report.  

See also: 

Viewing Accident Log Maps 

Back to Mapping Overview  

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: GPS to Mapping Software 
To export GPS data: 

1. Select Export in the File Menu. 
2. Select GPS to Mapping Software in the drop-down Export menu. The GPS Fields dialog 

box is displayed. 
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3. Only the checked GPS fields will be exported. Click on Select All to check all fields. Click 
on Clear all to clear all fields. Click in the box for each field to toggle the check on and off.  
4. Note: These key fields should always be selected: GPS DateTime, Speed, High Speed, 
Latitude and Longitude. 
5. Click OK in the GPS fields box to continue, click cancel to exit. If you click OK, the Export 
GPS To dialog box is displayed. 

 

3. The default file name is GPS.TXT and the default directory is the DriveRight FMS install 
directory. You can edit or change the file name directly in the text box. You can also change the 
directory in which the exported GPS data file will be saved.   
4. Click the "Set Filter" button to narrow the selection of GPS data to be exported.   
5. Click the Browse button to view the GPS data before you export it. 
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6. Press OK when you are ready to export the GPS data or click Cancel to exit without 
exporting data. If you click OK, the exported GPS data will be saved in a file ready to be imported 
into your mapping software. 

See also: 

Import GPS Data Into MapPoint 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: Accidents to Mapping Software 
To export accident log data: 

1. Select Accident to Mapping Software from the Export command in the File Menu. The Export 
Accidentlogs To dialog box is displayed. 

 

2. Select the file directory in which to save the accident log files. 
3. Verify the file name for the accident log file. You can edit the name in the dialog box if 
desired. 
4. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, the 
exported Accident Log data will be saved in a file ready to be imported into your mapping 
software. 

To import data into MapPoint: 

1. Start the MapPoint application. 
2. Select Import Data Wizard from the Data pull down menu. 
3. Using the File Dialog find select the ACCIDENTLOGS.TXT file and click on Open. 
4. "Tab" should be selected to separate the data. Click Next. 
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5. All the fields you exported will appear in the next dialog.  Column headings are included 
and should be detected by the program.  All the columns should have <Other Data> as 
their data type except Lat and Long.   Check to make sure the Lat and Long were 
detected correctly.  If they are not, correct them.  Click Finish. 

6. Choose Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select time_TO.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 
9. Click Finish to plot the points. 
10. In the left frame, right click on "time_T0 by Latitude & Longitude". Select "Properties". 

Open the Balloon tab and select time_T0, accidentDateTime and any other fields you 
want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show 
Information", to look at data for that particular point. 

12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are ‘+’ to zoom in and ‘-‘ to zoom out.  Also, you can draw a box around an area and then 
click in it to zoom into it.  You can scroll the map using your mouse by just positioning the 
mouse cursor on the side of the map you want to scroll into.   

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Import GPS Data Into MapPoint 
Exported GPS Data can be easily importing into MS MapPoint using the MapPoint Import Data 
Wizard. 
 
To import GPS data into MapPoint: 

1. Start the MapPoint application. 
2. Select Import Data Wizard from the Data pull down menu. 
3. Using the File Dialog find select the GPS.TXT file and click on Open. 
4. "Tab" should be selected to separate the data. Click Next. 
5. All the fields you exported will appear in the next dialog.  Column headings are included 

and should be detected by the program.  All the columns should have <Other Data> as 
their data type except Lat and Long.   Check to make sure the Lat and Long were 
detected correctly.  If they are not, correct them.  Click Finish. 

6. Choose Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select highSpeed.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 
9. Click Finish to plot the points. 
10. In the left frame, right click on "highSpeed by Latitude & Longitude". Select "Properties". 

Open the Balloon tab and select gpsDateTime, highSpeed and any other fields you want 
to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show 
Information", to look at data for that particular point. 
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12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are ‘+’ to zoom in and ‘-‘ to zoom out.  Also, you can draw a box around an area and then 
click in it to zoom into it.  You can scroll the map using your mouse by just positioning the 
mouse cursor on the side of the map you want to scroll into.   

 
See also: 
Export: GPS to Mapping Software 
 
Back to File Menu | Export Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
 

How to View Maps 

How to View Maps 
Viewing Trip Maps 
Viewing Day Maps 
Viewing Accident Log Maps 
 
Back to  FMS Quick Reference | Mapping Quick Reference 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Viewing Trip Maps 
The following topics will help you view and understand Trip Maps. 

Trip Map Features 
Map Navigation 
Viewing GPS Plot Information 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 
Viewing Day Maps 
The following topics will help you view and understand Day Maps: 

Day Map Features 
Map Navigation 
Viewing GPS Plot Information 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Viewing Accident Log Maps 
The following topics will help you view and understand Accident Log Maps: 

Accident Log Map Features 
Map Navigation 
Viewing GPS Plot Information 

Back to  Mapping Quick Reference Menu | How to View Maps 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Mapping Menu 

Note: DriveRight FMS Mapping requires Microsoft MapPoint.  

The following commands are available in the Mapping Menu: 
 
Open Map 
Save Map 
E-Mail Map 
MapPoint Version 
Set Speed Range 
 
 
See also: 
Mapping Quick Reference Menu 
DriveRight FMS Mapping Requirements 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

DriveRight FMS Mapping Requirements 

The following equipment and software are required to use DriveRight FMS mapping functions: 

• DriveRight 600  

• DriveRight GPS Module 

• Microsoft MapPoint 2002 or MapPoint 2004 

• In addition to the DriveRight FMS 3.2 system requirements, Microsoft recommends a 
minimum of 64 MB of memory to run MapPoint. 

• MS MapPoint or MapPoint Control run-time must be installed on the computer running 
the DriveRight FMS. 

Back to Mapping Quick Reference Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

 

Menu Commands 

Menu Commands Menu 

The following commands are available in the Main Menu: 
 
File Menu 
Setup Menu 
DriveRight Menu 
CarChip Menu 
Database Menu 
Reports Menu 
Mapping Menu 
Help Menu 
 
 
Back to Home 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

File Menu 

File Menu 

The following commands are available in the File Menu: 
 
Backup 
Restore 
Import 
Export 
Print 
Print Preview 
Print Setup 
Clear Screen 
Exit 
 
 
Back to Menu Commands 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Backup 

The Backup feature is used to archive old data as a zip file. The backup files are stored in the 
Backup sub-directory in the DriveRight FMS install directory. The Backup sub-directory is created 
the first time you back up your data.  
The backup zip files are named based on the start and end dates chosen for the backup. For 
example, if you pick the dates between March 6, 2003 and March 27, 2003, the backup file will be 
named 6March2003_27March2003.zip. 
You can configure how much data to keep active after a backup by setting up your Automation 
Option preferences in the Setup menu. Limiting the amount of data in the active database helps 
prevent the database from growing into an unmanageable size. 
 
To backup data: 

1. Click Backup in the File menu. The Backup Files To dialog box is displayed. 

 

2. From the Backup Files To dialog box select the folder where the backup file will be 
written. The Backup Options dialog box is displayed.  

Note: The Backup Options dialog box will not be displayed the first time you back up DriveRight 
data. 
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3. In the Backup Options dialog box check your last backup date and specify whether to 
backup the whole database or only those records falling within a specified time period. The start 
date will always be initialized to the last backup date. 
4. Click OK to initiate the backup or click Cancel to exit the dialog box without backing up 
your database. 
5. When the backup is finished, click OK to return to the program. 
 
 
See Also: 
Restore 
Preferences: Automation Options 
 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Restore 

The Restore command is used to get a previously Backed up data back into the active database. 
In this process you can pick one or more tables to be restored. 
 
To restore data: 

1. Click Restore in the File menu. The Restore Files From dialog box is displayed. 
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2. From the Restored Files From dialog box select a single zip file to restore, and then click 
the Restore button. DriveRight FMS unzips the file and displays all the tables in the dialog, and 
displays the following dialog box: 

 

Note: You can only restore one zip file at a time. 

Note: The backup file filename is based on the start and end dates chosen for the backup. 

3. You can either restore all the database tables or restore individual database tables. Click 
Yes in the dialog box to restore all the tables. Click No to restore selected database tables. 
4. If you are restoring selected database tables, select each table to be restored. Hold down 
the Control key on your keyboard to select multiple tables. When you have finished making your 
selection, click Restore to restore the tables or click Cancel to exit without restoring the tables.  
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5. When the files have been restored, click OK to return to the program. 
 
See Also: 

Backup 
 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
   

Import Menu 

Import Menu 
Use the Import Menu options to import DriveRight database data into DriveRight. 
 
Import: FTP Import 
Import: Import Data From 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Import: FTP Import 
FTP (File Transfer Protocol) Import allows you to import DriveRight data from a remote site. Use 
this procedure for FTP Import only. Use the Import: Other Import Commands procedure for all 
other import commands.  

Note: Before you start this operation, contact your systems administrator for your FTP account 
information. 

 
To use FTP Import: 

1. Select the Import command in the File Menu. 
2. Select FTP Import from the Import drop-down menu. The FTP Import dialog box is 

displayed. 

 

3. In the FTP HostName edit box, type the name of the FTP server that you want to import 
the database tables from. eg: toolbox.davisnet.com 
4. In order to access the FTP site you must have a user account on the FTP site. Enter your 
user name and password in the edit boxes. 
5. In the Remote Path edit box, you can enter a specific directory path in the FTP server.  
6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a 
different port. 
7. Default connection to the FTP site is active mode. Some FTP sites allow only passive 
mode connections.(check the passive mode check box in that case). For details, contact your 
system administrator. 
8. Click the Import button. The following FTP Import dialog box appears, which displays the 
directories and files located at the specified location on the FTP server. 
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9. Locate and select the sub-directory named for the DriveRight FMS location from which 
you want to import the database tables. Click Import to open the directory. 
10. Locate and select the zip file containing the database tables you wish to import. Click 
Import to import the tables. 
11. When the files have been successfully imported, click OK to return to the program. 

Note: You can quit at anytime during importing by clicking the Cancel button. 

 
See also: 
Import: Other Import Commands 
 
 
Back to File Menu | Import Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Import: Import Data From 
Use the Import tables command to import individual DriveRight Tables into your database. This is 
the procedure for all import commands except FTP Import. 
 
To import data: 

1. Select Import in the File Menu. 
2. Select the table you wish to import (Drivers, Vehicles, Trips, etc.) from the list. 
3. When the Import dialog box appears, go to the directory where the file to be imported are 

located. Select the file to be imported and click Import to import the data or click Cancel 
to exit without importing. 
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See also 
Import: FTP Import 
 
Back to File Menu | Import Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Export Menu 

Export Menu 
Use the export menu options to export DriveRight FMS data. 
 
FTP Export - Use the FTP Export command to export database data to a remote site. 
Export GPS to Mapping Software - Use the Export GPS to Mapping Software command to export 
GPS data in a format designed to be imported into mapping software. 
Export Accidents to Mapping Software - Use the Export Accidents to Mapping Software command 
to export accident GPS data in a format designed to be imported into mapping software. 
Other Export Commands - Use the other export commands to export the indicated type of data in 
a tab-delimited text file. 
 
 
Back to File Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Export: FTP Export 
FTP (File Transfer Protocol) Export shows all the available database tables that you want to 
export to the FTP site. By default all tables are selected. You can un-check the tables that you 
don’t  want to export. 

Note: Before you start this operation, contact your systems administrator for your FTP account 
information. 

 
Steps to follow: 

1. Select Export in the File Menu. 
2. Select the FTP Export from the menu list. The FTP Export dialog box is displayed. 

 

3. In the FTP Host Name box, type the name of the FTP server that you want to export the 
database tables.  
4. In order to access the FTP site you must have a user account on the FTP site. Enter your 
user name and password in the appropriate boxes. 
5. In the Remote Path box, you can enter a specific directory path in the FTP server to 
which to export your files.  
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6. Default port for the FTP site is 21. Use the default port unless the FTP site listens on a 
different port. 
7. Default connection to the FTP site is active mode. Some FTP sites allow only passive 
mode connections.(check the passive mode check box in that case). For details, contact your 
system administrator. 
8. Select the database tables to be exported by clicking the box for each table. Click a 
second time to de-select the table. 
9. If desired, you can export records that are dated within a specified time interval. The 
default start date for the interval is the last date of export. The default end date is the current 
date. You can change the start and end dates as required. If you have exported data previously, 
the last date of export is displayed in the dialog box. 
10. Click export button once you are done with the above steps.  
11. Application will create a sub-directory with your current location name on the FTP site, if it 
doesn't already exist, and then exports a ZIP file to the sub-directory. Default name for the export 
ZIP file is "day" + "month" + "year".zip (20jan2003.zip). 
 
 
Back to File Menu | Export Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Export: GPS to Mapping Software 
To export GPS data: 

1. Select Export in the File Menu. 
2. Select GPS to Mapping Software in the drop-down Export menu. The GPS Fields dialog 

box is displayed. 

 

3. Only the checked GPS fields will be exported. Click on Select All to check all fields. Click 
on Clear all to clear all fields. Click in the box for each field to toggle the check on and off.  
4. Note: These key fields should always be selected: GPS DateTime, Speed, High Speed, 
Latitude and Longitude. 
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5. Click OK in the GPS fields box to continue, click cancel to exit. If you click OK, the Export 
GPS To dialog box is displayed. 

 

3. The default file name is GPS.TXT and the default directory is the DriveRight FMS install 
directory. You can edit or change the file name directly in the text box. You can also change the 
directory in which the exported GPS data file will be saved.   
4. Click the "Set Filter" button to narrow the selection of GPS data to be exported.   
5. Click the Browse button to view the GPS data before you export it. 
6. Press OK when you are ready to export the GPS data or click Cancel to exit without 
exporting data. If you click OK, the exported GPS data will be saved in a file ready to be imported 
into your mapping software. 

See also: 

Import GPS Data Into MapPoint 

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: Accidents to Mapping Software 
To export accident log data: 

1. Select Accident to Mapping Software from the Export command in the File Menu. The Export 
Accidentlogs To dialog box is displayed. 
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2. Select the file directory in which to save the accident log files. 
3. Verify the file name for the accident log file. You can edit the name in the dialog box if 
desired. 
4. Click Export to create the accident log data file or click Cancel to exit.  If you click OK, the 
exported Accident Log data will be saved in a file ready to be imported into your mapping 
software. 

To import data into MapPoint: 

1. Start the MapPoint application. 
2. Select Import Data Wizard from the Data pull down menu. 
3. Using the File Dialog find select the ACCIDENTLOGS.TXT file and click on Open. 
4. "Tab" should be selected to separate the data. Click Next. 
5. All the fields you exported will appear in the next dialog.  Column headings are included 

and should be detected by the program.  All the columns should have <Other Data> as 
their data type except Lat and Long.   Check to make sure the Lat and Long were 
detected correctly.  If they are not, correct them.  Click Finish. 

6. Choose Multiple Symbol and click Next. These instructions show you how to color code 
accident log points by speed at T0. T0 is the middle point of the accident log.   

7. In "Select the data filed or column to map" list, select time_TO.  In "Divide the data you 
chose above by" list, select <None>. In "Show the data by" list, select Latitude & 
Longitude. Click Next. 

8. Enter the speed divisions you want to use and the color for each division. 
9. Click Finish to plot the points. 
10. In the left frame, right click on "time_T0 by Latitude & Longitude". Select "Properties". 

Open the Balloon tab and select time_T0, accidentDateTime and any other fields you 
want to view. 

11. Zoom in enough to see individual points, right click on a point, and pick "Show 
Information", to look at data for that particular point. 
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12. MapPoint allows you to navigate around on the map pretty well.  Some useful keystrokes 
are ‘+’ to zoom in and ‘-‘ to zoom out.  Also, you can draw a box around an area and then 
click in it to zoom into it.  You can scroll the map using your mouse by just positioning the 
mouse cursor on the side of the map you want to scroll into.   

Back to File Menu | Export Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Export: Export Data To 
Use the Export "data type" command to export the data in the database to a file. The exported 
files are in a tab-delimited text file format and can be used to exchange information within your 
company, with your clients, etc. 
To export data: 

1. Select Export in the File Menu. 
2. Select the data type you wish to export (Drivers, Vehicles, Trips, Costs, etc.) from the 

drop-down menu. The Export "data type" To window is displayed. The Export Trips To 
window is shown here as an example. 

 

3. Create a name for the file you wish to export on the Export File Name box (for example: 
Trips.txt). 
4. Use the browse function in the Export data type To dialog box to select a destination 
where you wish to place the file. 
5. In some cases, you can use the Set Filter option to more specifically specify the data to 
be exported (for example: export only information related to one driver, or a group, or a period of 
time, etc.). 
6. If you wish you can view the file before exporting by clicking the Browse button. This will 
give you the opportunity to view the selected records that will be exported. 
7. If the data is correct, you can click the Export button to create the export data file.  
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Back to File Menu | Export Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Print 

Use the Print command to print a DriveRight report that is displayed on your screen. 
 
To print: 

1. Click Print in the File menu. The print dialog box appears. 
2. Select your desired print options. 
3. Click OK to print or click Cancel to exit the dialog box without printing. 

 

Note: The Print command is only enabled when a report is being displayed. 

 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Print Preview 

To preview a print job: 
1. On the File menu, click Print Preview.  
2. Use the buttons on the toolbar to look over the page or make adjustments before printing.  

 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Print Setup 

To setup your print options:  
1. On the File menu, click Print Setup.  
2. Select your desired print options. 
3. Click OK to save the settings or click Cancel to exit the dialog box without saving. 

 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Clear Screen 

Use the Clear Screen command to clear reports from the main program window. 
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To clear the screen: 
1. Click Clear Screen in the File menu. The main program window is cleared. 
2. You can also use the Clear Screen icon to clear the screen: 

 

 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Exit 

Use the Exit command to close the DriveRight software. 
 
To exit the software: 

1. Click Exit in the File menu. The software quits. 
 
Back to File Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Setup Menu 

Setup Menu 

The following commands are available in the Setup Menu: 
 
Current Location 
Users 
Preferences 
Host Mode 
Communications Port - DriveRight 
Communications Port - CarChip 
Default DriveRight Settings 
Default CarChip Settings 
Digital Input Labels 
Corporate Structure 
 
 
Back to Menu Commands 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Current Location 

DriveRight 3.0 allows you to organize your data according to location.  All information is stored as 
part of the Current Location. You need to set Current Location value properly for proper data 
storage. Once current location name is set, the corresponding location id is stored in all the 
downloads. All operations like database browsing, reporting, etc, are performed with respect to 
the current location.  
 
To change the current location: 
 

1. Select Current Location command in the Setup Menu. The Set Current Location 
dialog box is displayed: 

 

2. Select the desired location from the drop-down list. 
3. Click Set to change the location or click Cancel to exit without changing the current 
location. 
 

Note: A new location can be added by going to Database->Company Locations, and clicking Add 
New button in the Browser. 

 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Users 

Users Menu 
The Users Menu commands allow you to log in and to change your password. If you are the 
Super User you can also browse the list of registered users. 
 
Login 
Browse/Add Users  
Change Password 
 
 
Back to Setup Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Users Menu 
The Users Menu commands allow you to log in and to change your password. If you are the 
Super User you can also browse the list of registered users. 
 
Login 
Browse/Add Users  
Change Password 
 
 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Users: Login 
The Users Login command allows you to change the User without exiting the program. You must 
be a registered user to access program functions. 
 
To change the current user: 
 

1. Select Login from the Users command in the Setup Menu. The Login dialog box is 
displayed. 

 

2. Enter your User Name and Password. 
3. Click OK to log in, or click Cancel to exit the dialog box without changing the current user. 
 
 
Back to Setup Menu | Users Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Users: Browse/Add 
The Users Browse/Add command opens the Users browse window showing you a list of all 
registered users, including their passwords. From this window you can add new users or edit the 
privileges of existing users. 

Note: You must be logged in as the Super User to access this command. 

To open the Users browse window: 
1. Select Browse/Add from the Users command in the Setup Menu. The Users browse 

window is displayed. 
2. Click on Add New to add a new user. 
3. To change a user's settings, click on the user in the browse window and then click on 

Edit. 
4. To delete a user, click on the user in the browse window and then click on Delete. 
5. To print the browse window, click on Print. 
6. Click Close to exit the window, or click on the close icon in the upper right corner of the 

window. 
 
See also: 
Add New User 
Edit User 
 
 
Back to Setup Menu | Users Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Users: Change Password 
The Users Change Password command allows you to change your DriveRight password.  
 
To change your password: 
 

1. Select Change Password from the Users command in the Setup Menu. The New 
Password dialog box is displayed. 
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2. Enter your new password, then retype your new password.  
3. If the retyped password doesn't match, you will be prompted to check the retyped 
password.  

Note: In order to change your password the new password and the retyped new password 
must match exactly. 

4. Click OK to change your password or click Cancel to exit the dialog box without changing 
your password. 
 
 
Back to Setup Menu | Users Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Preferences Menu 

You can set the following program preferences in DriveRight FMS: 
 
Units 
Automation Options 
Download Options 
Database Browser 
 
 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Preferences: Units 
The Units dialog box allows you to select the units used for distance and speed and also control 
the display of the time and date. 
 
To set units: 
 
1. Choose Units from the Preferences command in the Setup menu.  

The Units dialog box appears. 
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2. Select the desired distance/speed, date, and time options. 
3. Choose OK when you are satisfied with the settings, choose Cancel to exit without 
changing the settings. 
 
 
Back to Setup Menu | Preferences Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Preferences: Backup Options 
Use the Backup Options command to set the time interval at which DriveRight FMS will prompt 
you to backup your database and to set the number of months of records to keep in the active 
database. Refer to Active Database Size Recommendations and Database Backup 
Considerations for more information. 
 
To set your download options: 
 
1. Choose Backup Options from the Preferences command in the Setup menu.  

The Backup Options dialog box appears. 

 

2. Check the box for "Keep X months of records active in the database after every backup" 
then select the number of months from the drop down list to keep the selected number of months 
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active in the database after a backup. All data recorded before the specified period of time will be 
removed from the active database.  
 
See also: 
Database Backup Considerations 
Active Database Size Recommendations 
 
 
Back to Setup Menu | Preferences Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Preferences: Download Options 
Use the Download Options command to set up the automatic synchronization of the DriveRight's 
clock after each download and to determine how the software will handle the Driver ID set in the 
Trip 500AL and DriveRight 600 consoles. 
 
To set your download options: 
1. Choose Download Options from the Preferences command in the Setup menu.  

The Download Options dialog box appears. 

 

2. Select Synchronize time and date after every download to have your DriveRight unit's 
clock automatically reset to match your computer after each download. 

Note: If you choose this option, all DriveRight consoles included remote units downloaded 
through host mode will be reset to the computer’s time and date, even if the remote DriveRight is 
in a different time zone. 

3. If you are using DriveRight Trip 500AL or DriveRight 600 consoles, set the DriverID as 
either the Location ID or the Driver ID. 
4. Select Include last hours of speed and GPS logging to determine number of hours of 
speed data the recorded by the CarChip that the FMS software keeps. To save database 
space, CarChip uses the default setting of 1 hour and saves the last hour of GPS and Speed 
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Interval data that gets displayed in the GPS database table. Select this check box and enter 
the number of hours of speed and GPS logging data you want to keep. 

Note: The maximum number of hours of speed and GPS logging information that can be 
downloaded and stored is 9 hours. To minimize download times and limit the amount of database 
server space used, it is recommended that the default of one hour be used. Note that by 
increasing the number of hours of speed and GPS logging information that is kept increases the 
amount of time it takes to download information from the CarChip to the software. 

5. Click OK to save the changes, click Cancel to exit without saving. 
 
 
Back to Setup Menu | Preferences Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Preferences: Database Browser 
Use the Database Browser commands to change the text font and color and the background 
color used in the Browser windows. 
 
Text Font and Color 
Background Color 
 
Back to Setup Menu | Preferences Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Host Mode 

Host Mode Menu 
Host Mode allows drivers to dial in remotely and download their DriveRight using a modem. 
 
Host Mode On 
Host Mode Setup 
Remote Modem Setup 
 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Host Mode On 
This is the mode that your modem should be in when someone wants to call in from outside to 
transfer data from one or more DriveRight devices. A dialog box appears indicating that the 
modem is being initialized. After the initialization has been completed successfully, the other party 
can call in. When the Host Mode is on, all other software operation are suspended. 

Tip: It’s a good idea to set a schedule for remote drivers to call into the Host computer. For 
example, setting the rules to call outside business hours, then leaving the computer in Host Mode 
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as the last task of the day will give drivers flexibility to call in. Alternatively, one computer can be 
dedicated as the Host, and data can be exported from it periodically to another computer where 
analysis and reporting are performed. 

• The user connects his modem to the DriveRight (showing the CURRENT screen) using 
the remote download Kit (item #8188, purchased separately).  

• The host mode is a well-protected function. You can only communicate as long as a 
DriveRight is connected to your PC. In all other cases, communication is lost. 

• For details on how to install a remote modem to enable it to participate in the Host Mode, 
please consult the instructions accompanying the Remote Download Kit. 

• The History Window displays status information for downloaded DriveRights.   
• Hang Up:  Generally, you will not need this button because the software will hang up 

automatically. However, if necessary you can manually hang up the phone using this 
button. 

• Reinitialize Modem: Resets the modem initialization. 
• Exit Host Mode:  Exit host mode and resume normal program operation. 

 
See also: 
Host Mode Menu 
Host Mode Setup 
Host Mode: Remote Modem Setup 
 
 
Back to Setup Menu | Host Mode Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Host Mode Setup 
Host Mode Setup allows you to configure your computer’s modem to accept calls. 
To be able to communicate with the DriveRight and transfer data over a modem, the 
communications port should be defined for your modem. Furthermore, set the modem of your PC 
to Auto-Answer when there is a call. Refer to your modem manual for Auto-Answer. 

• Select the COM Port that your modem is connected too.   

• The default initialization strings are "AT E1 Q0 &B1 &N0 V1" and "ATS0=3" for string 1 
and string 2.   

• Click Detect Modem to detect the serial port to which the modem is connected. 

• If you are going to download just DriveRight 500 AL and earlier models just check that 
box.  See description below for explanation as to why this is necessary. 
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Note: Because the DriveRight 500 and earlier versions of DriveRight communicate at 2400 baud 
and the DriveRight 600 communicates at 19,200 baud, you must configure your computer to 
communicate with either the DriveRight 600 or with earlier models.  

 
See also: 
Host Mode On 
Host Mode: Remote Modem Setup 
 
 
Back to Setup Menu | Host Mode Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Remote Modem Setup - Using Hyper Terminal 
The external modem at the site where the DriveRight is connected is called the "remote" modem. 
The DriveRight owner, when he wants to download his information, connects the DriveRight to 
this modem using the interface box and modem adapter included in the Remote Modem Kit. He 
then turns the modem on, and it will dial the host computer and the download will be initiated. 
However, before the modem will dial up the host computer and download correctly it must be set 
up correctly. The following instructions explain how to do this manually for a US Robotics Courier 
V. Everything modem and the Windows 95 accessory program Hyper Terminal. In addition, the 
setups for US Robotics 56K Fax Ext are included.   
Unfortunately, not all modems have the same command set or act the same way on power up. If 
you are using a modem other than the one described, read the instructions below and then refer 
to your specific modem documentation to determine if your modem can be used. 

Note: When you are asked to type a command, do not type the quotes.  Type all commands in 
upper case. 
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1. Take the modem out of the box and check that the DIP switches are set in the following 
way: 

Switch Number:  1  2  3  4  5  6  7  8  9 10 
Switch Setting:   0  0  0  1  1  0  0  1  0  0 

Note: 0 is short for OFF and 1 is short for ON.  These DIP switches only apply to the US Robotics 
Courier V. Everything modem. 

2. Using the Remote Modem Kit, connect the remote modem to a known serial port, and 
then turn the modem on. Make sure you use the gray phone cable included in the kit to go from 
your serial port to the modem. The black phone cable included in the DriveRight Software kit will 
not work for a modem. 
3. Run the Hyper Terminal  program. You can find the program in the Start menu under 
Programs/Accessories/Hyper Terminal. Click on one of the phones in the program group to start 
the program. 
4. Select "Properties" from he File menu and make sure you have the correct serial port 
selected. If you are not sure, you will have to use trial and error. In most cases "Direct to COM1" 
or "Direct to COM2" should work.  The File/Save As command can be used to save these settings 
under a name of your choice. You then can click on the phone with this name to start Hyper 
Terminal next time. 
5. Type the letters "AT" and press enter. If you get an OK back, you are communicating with 
the modem.  If you do not, type the following commands. 

"ATE1V1Q" and press Enter 
You should now be able to type "AT" and press enter and receive an OK back.  You 
should also be able to see the "A" and the "T" when you type them. 
If the above test fails, check your connections and then try another COM port by 
changing your selection in the Properties option in the File menu. 

6. Enter the following commands to program the modem.  You should receive an "OK" after 
each one of the commands below unless stated otherwise. 

"ATS13=16" and press Enter 
Now, you will program the phone number to be dialed.  In the example below, the host 
computer is connected to 780-6455. 

"AT&Z0=780-6455" and press Enter 
Now the modem will dial this number when it is turned on. 

"AT&W" and press Enter 
This setup is now saved in non-volatile memory which is loaded when the modem is 
turned on. 

"AT&M4" and press Enter 
This tells the modem to use a standard error detection protocol which should be used 
to insure the data transfer is done error free. 

"ATE0Q1" and press Enter 
You will not receive an "OK" after this command.  "Q1" tells the modem to operate in 
"quiet" mode. This is necessary so the DriveRight does not interpret any responses 
from the modem as commands. Note also, command will no longer be echoed. If you 
type AT Enter, you will see nothing; however, this is what we want and why we waited 
to do this on the last step. 

7. Exit Hyper Terminal: You are now ready to test your programming. If you have two 
separate phone lines and the DriveRight software you can completely test your setup. Plug in a 
working phone line to the remote modem and the "correct" phone line into your computers 
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internal or external modem. The "correct" line is the one belonging to the number you 
programmed in step 5. Run the DriveRight software and put it in "host" mode by selecting "Host 
Mode On"  in the Setup/Host Mode menu. Connect the DriveRight to be downloaded to the 
external modem through the interface box and the black cable, not the gray cable you used to 
program the modem. Turn the modem off and then back on again. The modem should dial the 
host, the computer should answer the call and download the data. The DriveRight owner knows 
the download is completed when the CD light goes off. Under any circumstances, the download 
should be completed in no more than 5 minutes. 
Below are the modem configurations for the US Robotics modems used during testing. 
FIELD MODEM: 

For DriveRight 500 make sure &N3 (if DriveRight 600 not selected in Host Mode Setup 
&N0 will also work.) 
For DriveRight 600 make sure &N0 or &N10. 

USRobotics Courier V.Everything Settings... 
   B0  C1  E0  F1  M1  Q1  V1  X1 
   BAUD=19200  PARITY=N  WORDLEN=8 
   DIAL=TONE   ON HOOK   TIMER 
   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1  &L0  &M4  &N3 
   &P0  &R1  &S0  &T5  &U0  &X0  &Y1  %N6  #CID=0 
   S00=000  S01=000  S02=043  S03=013  S04=010  S05=008  S06=002  S07=060 
   S08=002  S09=006  S10=014  S11=070  S12=050  S13=016  S14=001  S15=000 
   S16=000  S17=000  S18=000  S19=000  S20=000  S21=010  S22=017  S23=019 
   S24=150  S25=005  S26=001  S27=000  S28=008  S29=020  S30=000  S31=000 
   S32=009  S33=000  S34=000  S35=000  S36=000  S37=000  S38=000  S39=000 
   S40=000  S41=000  S42=126  S43=200  S44=015  S45=000  S46=000  S47=000 
   S48=000  S49=000  S50=000  S51=000  S52=000  S53=000  S54=064  S55=000 
   S56=000  S57=000  S58=000  S59=000  S60=000  S61=000  S62=000  S63=000 
   S64=000  S65=000  S66=000  S67=000  S68=000  S69=000  S70=000 
   LAST DIALED #: T293-3529 
Switch 4,5, and 8 ON all others off. 

FIELD MODEM: 
For DriveRight 500 make sure &N3. 
For DriveRight 600 make sure &N0 or &N10. 

U.S. Robotics 56K FAX EXT Settings... 
   B0  E0  F1  M1  Q1  V1  X1  Y0 
   BAUD=19200  PARITY=N  WORDLEN=8 
   DIAL=TONE    ON HOOK   CID=0 
   &A1  &B0  &C1  &D2  &G0  &H0  &I0  &K1 
   &M4  &N10  &P0  &R1  &S0  &T5  &U0  &Y1 
   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 
   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=016 
   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 
   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 
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   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 
   S41=000  S42=000 
   LAST DIALED #: T2933529 
SWITCH 4,8 ON all others OFF. 

HOST MODEM: 
U.S. Robotics 56K FAX EXT Settings... 

   B0  E1  F1  M1  Q0  V1  X1  Y0 
   BAUD=19200  PARITY=N  WORDLEN=8 
   DIAL=TONE    ON HOOK   CID=0 
   &A1  &B1  &C1  &D2  &G0  &H0  &I0  &K1 
   &M4  &N0  &P0  &R1  &S0  &T5  &U0  &Y1 
   S00=004  S01=000  S02=043  S03=013  S04=010  S05=008  S06=004 
   S07=060  S08=002  S09=006  S10=014  S11=070  S12=050  S13=000 
   S15=000  S16=000  S18=000  S19=000  S21=010  S22=017  S23=019 
   S25=005  S27=000  S28=008  S29=020  S30=000  S31=128  S32=002 
   S33=000  S34=000  S35=000  S36=014  S38=000  S39=000  S40=001 
   S41=000  S42=000 
   LAST DIALED #: 
SWITCH 3,8 ON all others OFF. 

DriveRight Software Host Mode Setup 
Inititialization String 1: AT E1 Q0 &B1 &N0 V1 
Inititialization String 2: ATS0=3 

 
See also: 
Host Mode On 
Host Mode Setup 
 
Back to Setup Menu | Host Mode Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Communications Port - DriveRight Settings 

Use the Communications Port - DriveRight Settings command to select the communications port 
used to connect a DriveRight device to your computer. 
 
To select a communications port: 
 

1. Choose the Communications Port - DriveRight command in the Setup Menu. The 
Communications Port Settings dialog box is displayed: 
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2. Select the communications port from the list provided. DriveRight FMS supports COM1 
through COM8. 
3. If you are not sure which communication port you are using, connect your DriveRight to 
your computer: 

o Press the Mode button on the DriveRight if necessary to make sure the device is 
on. 

o Click the Auto Detect button.  
o If the DriveRight is found by the software, the following message is displayed and 

the correct communications port is selected in the dialog box. 

 

4. Click OK to save the serial port selection or click Cancel to exit the dialog box without 
changing the serial port. 
 

Note: If you are working on a network, ask the network administrator to assist you in selecting the 
correct communications port.  

 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Communications Port - CarChip Settings 

Use the Communications Port - CarChip Settings command to select the communications port 
used to connect a CarChip device to your computer. 
 
To select a Communications port: 
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1. Choose the Communications Port - CarChip from the Setup Menu. The 
Communications Port Settings dialog box is displayed: 

 

2. Select USB if using a USB connection or the correct COM port for the serial port 
connection from the list provided. DriveRight FMS supports USB and COM1 through COM8. 
3. If you are not sure which communications port you are using, connect your CarChip to 
your computer, click the Auto Detect button. If the CarChip is found by the software, the following 
message is displayed and the correct communications port is selected in the dialog box. 

 

4.  Click OK to save the communications port selection or click Cancel to exit the dialog box 
without changing the communications port information. 

Note: If you are working on a network, ask the network administrator to assist you in selecting the 
correct communications port.  

 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Default DriveRight Settings Menu 

Default DriveRight Settings Menu 
Use the Default DriveRight Settings Wizard to create default device settings which are used by all 
new DriveRights added to the system. Use the View/Set command to review or edit the default 
settings. 
 
View/Set 
Setup Wizard 
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Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Default DriveRight Settings Wizard 
The values entered in this setup are used as default settings when you add new DriveRight 
devices to the database. If you click this menu option , a dialog box pops up that contains a brief 
description about the Default DriveRight Settings Wizard.  
 
To edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  
2. Select Setup Wizard from the list of commands. The Default DriveRight Wizard dialog 

box is displayed. 

 

3. If you select OK, the Default DriveRight Settings Wizard takes you through the dialog 
boxes listed below: 

• Unit Settings: Select the date, time and unit modes and click OK. 

• Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

• Timer Settings:Enter the trip stop time and driver log out time and click OK. 
• Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

• Security Settings: Enter the security code (PIN code). Tamper indicator is an 
option.  

4. Once you are finished with the above five dialog boxes, a tab control dialog box appears 
with all the above five dialog boxes. You can navigate through them, change any of the settings, 
and save the settings by clicking OK. 
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Back to Setup Menu | Default DriveRight Settings Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Default DriveRight Settings View/Set 

Default DriveRight Settings View/Set 

Use the Default DriveRight Settings View/Set command to view or edit the DriveRight FMS 
default DriveRight console settings..  
 
To view or edit the Default DriveRight Settings:  

1. Select Default DriveRight Settings in the Setup Menu.  
2. Select View/Set from the list of commands. The Default DriveRight Settings dialog box 

is displayed. 
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3. Select a tab to view or edit the following default settings: 
• Unit Settings: Select the date, time and unit modes and click OK. 

• Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

• Timer Settings:Enter the trip stop time and driver log out time and click OK. 

• Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 
• Security Settings: Enter the security code (PIN code). Tamper indicator is an 

option.  

• GPS Settings: Turn the GPS logging and subsequent mapping feature on and off 
and select mapping features. Works only with DriveRight 600 units with GPS 
modules. 

4. When your are finished, click OK to save any changes or click Cancel to exit without 
saving changes. 
 
 
Back to Setup Menu | Default DriveRight Settings Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Unit Settings 

Use this command to create default unit settings that can be used by all the vehicles in your fleet. 
 
To set default unit settings: 
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1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu. The 
Unit Settings screen in the Default DriveRight Settings dialog box is displayed. 

 

3. Edit the unit settings for your fleet.  
o Date Mode settings control the way month, day, and year are displayed. 
o Time Mode settings control the time of day display. 
o Distance Unit settings allows you to select miles and miles per hour or kilometers 

and kilometers per hour as your speed and distance units. 
4. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
 
See also: 
Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Safety Settings 

Use this command to create default DriveRight safety settings. 
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To set default safety settings: 

1. Select View/Set from the Default DriveRight Settings submenu  from the Setup menu The 
Default DriveRight Settings dialog box is displayed. 

2. Select the Safety Settings tab near the top of the dialog box. The safety options are 
displayed. 

 

4. Set the Speed Limit, which is the maximum allowable vehicle speed. 
5. Set the Accel Limit, which is the maximum allowable rate of acceleration. 
6. Set the Decel Limit, which is the maximum allowable rate of deceleration. 
7. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
 
See also: 
Unit Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Timer Settings 

Use this command to create default timer settings that can be used by all the vehicles in your 
fleet. 
 
To set Fleet default timer settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu The 
Default DriveRight Settings dialog box is displayed. 

2. Select the Timer Settings tab near the top of the dialog box. The timer options are 
displayed. 

 

3. Set the trip stop time in minutes. The trip stop time is the number of minutes that elapse 
after a vehicle stops before the DriveRight stops recording trip data. 
4. Set the Driver ID Logout Time in minutes. Use a logout time of "0" to never log out the 
driver. The Driver ID Logout Time is the number of minutes that elapse after a vehicle stops 
before the driver is logged out of the DriveRight. 
5. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
 
See also: 
Unit Settings 
Safety Settings 
Alarm Settings 
Security Settings 
GPS Settings 
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Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Alarm Settings 

Use this command to create default alarm settings that can be used by all the vehicles in your 
fleet. The alarm settings control the audible alarms used to indicate when the safety settings 
thresholds are exceeded. 
 
To set default alarm settings for all DriveRight devices: 

1. Select View/Set from the Default DriveRight Settings submenu in the Setup Menu. The 
Default DriveRight Settings dialog box is displayed. 

2. Select the Alarm Settings tab near the top of the dialog box. The Alarm settings options 
are displayed. 

 

4. Set the Alarm Mode to On or Off. This controls audible alarm reporting by the DriveRight 
device. 
5. Enable "Warn if not Logged in" to have the DriveRight device give an audible alarm if the 
vehicle is operated without the driver first entering his or her driver code. 
6. Click OK to save the Alarm Settings, click Cancel to exit without saving the settings, or 
click on another tab to make additional changes to the DriveRight default settings. 
 
See also: 
Unit Settings 
Safety Settings 
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Timer Settings 
Security Settings 
GPS Settings 
 
Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Security Settings 

Use this command to create default DriveRight security settings. 
 
To set default security settings: 

1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu The 
Default DriveRight Settings dialog box is displayed. 

2. Select the Security Settings tab near the top of the dialog box. The security options are 
displayed. 
 

 
3. Set the Pin Code, which is required to set the calibration and alarm settings on the 

DriveRight device. 
4. If desired, you can enable the tamper indicator. If enabled, the tamper indicator on the 

DriveRight LCD screen will be displayed when a tamper event has been detected.  
5. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 

another tab to make additional changes to the DriveRight  settings. 
Unit Settings 
Security Settings 
Timer Settings 
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Alarm Settings 
GPS Settings 
Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

GPS Settings - Default DriveRight Settings 

Use this command to create default GPS settings that can be used by all the vehicles in your 
fleet. 

Note: Even if this feature is toggled on an off, it will only work with corresponding DriveRight 600 
units with GPS modules. 

To set default GPS Logging settings: 
1. Select View/Set from the Default DriveRight Settings submenu from the Setup menu The 

Default DriveRight Settings dialog box is displayed. 
2. Select the GPS Settings tab near the top of the dialog box. The GPS options are 

displayed. 

 
3. Select On to turn the GPS logging feature on for all the units with a GPS module. Select 
Off to turn off the GPS feature for all DriveRight Devices. Select DriveRight Speed Only to log 
and track only the DriveRight Speed. This feature logs and tracks only the DriveRight speed for 
DriveRight 600 devices that are not assembled with a GPS module. 
4. If On or the DriveRight Speed only button has been selected, select the Logging interval 
time and corresponding time unit in the Log Data Every text field. The amount of logging hours 
this used for this feature are displayed in Logging Hours. 
5. Click OK to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
See Also: 
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Unit Settings 
Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
 
Back to Setup Menu | Default DriveRight Settings | Default DriveRight Settings - View/Set 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Default CarChip Settings 

Use the Default CarChip Settings command to view or edit the DriveRight FMS defaults for the 
CarChip device settings..  
 
To view or edit the Default CarChip Settings:  

1. Select Default CarChip Settings in the Setup Menu. The Default CarChip Settings dialog 
box is displayed. 

 

2. You can edit the settings for Hard Braking, Acceleration, Speed Bands, and Engine 
Parameters. 

o The CarChip settings for Hard Braking Threshold, Hard Acceleration Threshold, 
and Speed Band 3 are equivalent to the DriveRight settings for Decel Limit, Accel 
Limit, and Speed Limit. 

o Set the Hard Braking Threshold to equal the Decel Limit used by DriveRight 
Devices. 
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o Set the Hard Acceleration Threshold to equal the Accel Limit used by DriveRight 
Devices. 

o Set Speed Band 3 to equal the Speed Limit used by DriveRight Devices. 
3. When your are finished, click OK to save any changes or click Cancel to exit without 
saving changes. 
 
 
Back to Setup Menu  
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Digital Input labels 

You can identify the two digital inputs signals available on a DriveRight 600 using this  dialog box. 
Digital inputs are any variable from the vehicle that produces a high and a low voltage input. The 
DriveRight device records these high and low voltage differences for the inputs that you select. 
These digital inputs get incorporated into various database displays and reports throughout the 
software, such as the Accident Log Report, the Trip Database  and the GPS database. 
 
To change the digital input labels: 
 

1. Click Digital Input Labels in the Setup menu. The Digital Input Labels dialog box is 
displayed. 

 

2. Edit the labels used for digital input 1 and digital input 2. The following is a list of possible 
labels used as digital inputs: 

• Seat belts 
• Headlights 
• Braking 
• Lights 
• Windshield wipers 

Note: Depending on the selected digital input, extra setup between the DriveRight and the vehicle 
may need to happen to monitor these digital inputs correctly. For Example: To make "Seat belts" 
a digital input, locate a wire bundle underneath the driver's set, pick a wire from the bundle and 
test it's voltage during buckling and buckling. Do this until you find the wire that goes from 0 to 12 
volts when buckling and buckling and connect it to the green wire of the adapter cable supplied 
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with the DriveRight. Connecting other aspects of your vehicle to be monitored by the DriveRight 
system varies. 

3. Click OK to save the changes or click Cancel to exit without saving the changes. 
 
Back to Setup Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Corporate Structure 

The Corporate Structure dialog box allows you to set up reporting structure for all the locations 
listed in a database. The resulting location structure can be used as a tool for displaying the 
Driver Safety Score Report, breaking up driver and fleet information based on locations and the 
reporting structure. 
To create and edit the corporate reporting structure: 

1. Select Corporate Structure from the Setup menu The Corporate Structure dialog box is 
displayed. 
 

 
  

2. Use the location combo boxes to create or edit the corporate location structure. Select a 
Location from the Available Locations in Database box and click the >> button to move 
the Location to into the Corporate Structure box.  
 
If a selected location is a root location, meaning it is as the top of the corporate structure, 
Select the Root Location check box.  
 
To assign a location under a location, highlight the location with a higher hierarchical title 
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in the Corporate Structure box, select a location from the Available Locations In 
Database box and click the >> button. The selected location displays underneath the 
highlighted location. 
 
To Delete a location, or hierarchy of locations, select a location and click the << button. 
This removes the location from the corporate structure. 
 
If there are gaps or unknown reporting structures in certain structure hierarchies, the 
NULL location may be used. For example, if a location reports indirectly, or through 
unknown paths to higher hierarchical location, the NULL location can be used to signify 
the unknown path or location. 
 

 
  

3. Complete your corporate structure and click OK to save the corporate information, or 
Cancel to exit without saving the information. 

 
 
Back to Setup Menu  
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

DriveRight Menu 

DriveRight Menu 

Use DriveRight Menu commands for functions that require direct communications with the 
DriveRight console.  

Note: The DriveRight must be connected to your computer with the LCD display on and in the 
CURRENT mode in order to access the DriveRight Menu commands. 

The following DriveRight Menu commands are available: 
 
Add New DriveRight 
DriveRight Settings 
Download DriveRight 
Download Palm 
Read Accident Log 
Read Tamper Log 
Set Time and Date 
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Set Odometer 
Set Service Alarms 
Set Drivers List 
Clear DriveRight 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Add DriveRight Wizard 

DriveRight FMS includes an Add DriveRight Wizard to simplify adding DriveRight devices, 
Vehicles, and Drivers to the database.  
To add a new DriveRight device: 

1. Select Add New DriveRight from the DriveRight Menu. The Add DriveRight Wizard - Start 
dialog box is displayed. 

Note: The new DriveRight device must be connected to your computer and be turned on before 
you can add it to the DriveRight FMS database.  

 

2. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 
o If you click Next, the Add DriveRight Wizard - DriveRight ID dialog box is 

displayed. 
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3. Click Next to continue or click Cancel to exit the Add DriveRight Wizard. 
o If you click Next, the Add DriveRight - Assign to Vehicle dialog box is displayed. 

 

4. Click OK to continue, or click Cancel to exit the Add DriveRight Wizard. 
5. If you click Ok, the Add DriveRight Settings dialog box is displayed. The Add DriveRight 
Settings Dialog allows you to review all of the settings for the new DriveRight, including those 
settings that are set by the DriveRight defaults.  
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6. When you are satisfied it is set up correctly, select Set to save the settings. Select Cancel 
to exit the setup dialog and abandon the DriveRight settings. 

Note: If you cancel the setup, you will lose the DriveRight settings but any vehicles or drivers you 
added to the database will remain. 

 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRight Settings 

The following commands allow you to view and or change the settings on a DriveRight device: 
 
View/Set 
Restore 
Setup GPS 
Verify DriveRight Calibration 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Download DriveRight 

The Download DriveRight command transfers trip data from the connected DriveRight device to 
the DriveRight database.  
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To download your DriveRight: 
 

1. Connect your DriveRight console to your computer and make sure the DriveRight is 
"awake". Press the MODE key if there is nothing on the LCD display. 

2. Select Download DriveRight in the DriveRight Menu. The following Download Status box 
is displayed: 

Note: You will see the Cancel button only if you are downloading a DriveRight 600. 

 

3. You may lose GPS data for earlier trips if the DriveRight console is not downloaded for 
an extended period of time. In this case you will see a warning message similar to this: 

 

4. If the calibration in the DriveRight console does not match the calibration in the database, 
you will see a warning message similar to this: 
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5. When the data has finished downloading the following dialog box is displayed: 

 

6. Press Enter or click OK to continue. 
 
See also: 
Downloading DriveRight Guidelines 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Download Palm 

DriveRight 3.0 offers a new feature to download data from multiple DriveRight devices from a 
Palm device. You will need the DriveRight Palm Download Kit, #8181, in order to use this 
command. 

Note: To download a DriveRight console data into the software using Palm Download, the 
DriveRight should be present in the database. If you try to download a DriveRight which is not 
present in the database, you will get an error message.  

 
To download your Palm: 

1. Select Download Palm in the DriveRight Menu.  
2. The first time you download a Palm, the following dialog box is displayed. Select the 

directory which contains your Palm backup databases and click OK. 
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3. Each time after the first time, when you use the Download Palm command, the following 
dialog box appears showing the selected Palm backup directory.  

 

4. Click Browse to select a different backup directory, click OK to use this displayed 
directory, or click Cancel to exit. 
5. If you click OK the Download Status dialog box is displayed.  
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6. When the data has finished downloading the Palm Download, Download Successful 
dialog box is displayed: 

 

7. Click OK to continue. 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Read Accident Log 

The Read Accident Log command will download accident log data from the connected DriveRight 
device, convert it to a text file, and display it using MS Notepad. 
 
To read the accident log: 
 

1. Select Read Accident Log in the DriveRight Menu. The accident log is displayed. 
 
See also:  
Accident Log 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Read Tamper Log 

The Read Tamper Log command will download Tamper Log data from the connected DriveRight 
device, convert it to a text file, and display it using MS Notepad. The Tamper Log holds the times 
and dates when the driver disconnected the DriveRight or tried to change the DriveRight Settings. 

Note: There must be a Settings PIN-Code in the unit to enable the logging of disconnect times.  

 
To read the tamper log: 
 

1. Select Read Tamper Log in the DriveRight Menu. The tamper log is displayed. 
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See also:  
Tamper Log 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Time and Date 

Use this command to set the time and date on a DriveRight device. 
 
To set the time and date on a DriveRight: 

1. Select Set Time and Date from the DriveRight Menu. The Set Time and Date dialog box 
is displayed. 

 

2. Set the Date by either clicking the month, day or year in the edit box and entering the 
new information, or by clicking on the down arrow and selecting the date from the drop-down 
calendar. 

 

3.  Set the time by clicking on the hour, minute or second in the edit box and entering the 
new time. You can also adjust the time settings up and down using the up and down arrows in the 
edit box. 
4. Click on Set to change the time and date on the DriveRight unit or click on Cancel to exit 
the dialog box without changing the settings. 
 
 
Back to DriveRight Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Odometer 

Use this command to set the vehicle odometer reading in a DriveRight device. 
 
To set the odometer in a DriveRight: 

1. Select Set Odometer from the DriveRight Menu. The Set Odometer dialog box is 
displayed showing the current odometer reading. 

 

2. You can now edit the vehicle's odometer reading. 
3. Click on OK to update the odometer reading on the DriveRight unit or click on Cancel to 
exit the dialog box without changing the settings. 

Note: When you set the odometer DriveRight FMS updates the current odometer value of the 
vehicle assigned to this DriveRight and also adds a new entry in the Odometer Logs Table. 

 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Set Service Alarms 

Note: Available for the DriveRight Trip 500 AL only. 

Each vehicle needs a service check from time to time. With the Set Service Alarms option you 
can specify the Odometer Readings on which the vehicle should go in for service. After defining a 
Service Schedule you can assign it to a vehicle and load it into the DriveRight Trip 500AL using 
the Set Service Alarms command in the DriveRight menu. As soon as any defined odometer 
readings are reached, a warning signal is activated in the vehicle indicating the driver to bring his 
vehicle in for a service check, or call his service center for an appointment. 
 
To set a service alarm: 
 

1. Select Set Service Alarms from the DriveRight Menu. The Set Service Alarms dialog box 
is displayed. 
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2. Enter the odometer reading for a service alarm. 
3. Click the Add>> button to add the service alarm for that odometer reading. 
4. Click on an odometer reading to highlight it, then click the Delete button to remove a 
specific service alarm. 
5. Click the Clear All button to remove all service alarms. 
6. Click on Set to Device to update the service alarm settings on the DriveRight unit or click 
on Cancel to exit the dialog box without changing the settings. 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Drivers List 

This is a new feature added in DriveRight 3.0. DriveRight 600 device provides a security feature 
which lets the operator set up to 100 drivers’ codes into the device to have access.  
 
To set the drivers list: 

1. Select Set Drivers List from the DriveRight Menu. The Set Drivers List dialog box is 
displayed. Drivers already assigned to this DriveRight are displayed in the right column. 
Drivers not assigned to this DriveRight are displayed in the left column. 
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2. Click on a driver's name to select the driver, the click on the right arrows ">>" to move the 
driver to the "to set in DriveRight" list. 
3. To remove a driver from the DriveRight list, click on a driver's name to select the driver, 
then click on the left arrows "<<" to move the driver off the DriveRight list. 
4. Click on Set to Device to update the drivers list on the DriveRight unit or click on Cancel 
to exit the dialog box without changing the drivers list. 
5. If you click on Set to Device, then you will see the following dialog box if the action is 
successful. Click on OK or press Enter to continue. 

 

 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Clear DriveRight 

The Clear DriveRight command clears all trip data in the connected DriveRight.  
 
To Clear your DriveRight: 
 

1. Select Clear DriveRight in the DriveRight Menu. The following DriveRight dialog box is 
displayed: 

 

2. Click Yes to clear the DriveRight device, click No to cancel the command. 
 
 
Back to DriveRight Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

CarChip Menu 

CarChip Menu 

Use CarChip Menu commands for functions that require direct communications with the CarChip 
device.  

Note: The CarChip device must be connected to your computer in order to access the CarChip 
Menu commands. 

The following CarChip Menu commands are available: 
 
Add New CarChip 
CarChip Settings 
Download CarChip 
Set Time and Date 
Set CarChip LED State 
Display CarChip Memory 
Show CarChip Info 
Clear CarChip Memory 
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Back to Menu Commands Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Add CarChip Wizard 

DriveRight FMS includes an Add CarChip Wizard to simplify adding CarChip devices to the 
database. Click on the links provided for each of the Add CarChip Wizard dialog boxes to see 
more detailed information. 
 
To add a new CarChip device: 

1. Select Add New CarChip from the CarChip Menu. The Add CarChip Wizard - Start dialog 
box is displayed. 

Note: The new CarChip device must be connected to your computer in order to add it to the 
DriveRight FMS database.  

 

2. Click Next to continue or click Cancel to exit the Add CarChip Wizard. 
o If you click Next, the Add CarChip Wizard - CarChip ID dialog box is displayed. 

 

3. Click Next to continue or click Cancel to exit the Add CarChip Wizard. 
o If you click Next, the Add CarChip Wizard - Assign dialog box is displayed. 

Note: CarChip should be assigned to either a vehicle or driver. If it is assigned to a vehicle, the 
default driver of that vehicle appears on all the data downloaded. If a CarChip is assigned to a 
driver, then all data downloaded from that CarChip will be associated with that driver and the 
vehicle will be listed as UNKNOWN VEHICLE. This is useful if the driver uses multiple vehicles 
with the same CarChip. Based on your particular case, you should carefully choose between 
assigning a CarChip to a vehicle or a driver. 

 

4. After assigning the CarChip to either  a vehicle or to a driver, Click Next to continue or 
click Cancel to exit the Add CarChip Wizard. 
If you are assigning the CarChip to a vehicle, the Vehicles database table is displayed. 
Click on a vehicle record in the database table to highlight it, then click Select to assign 
the CarChip to the selected vehicle. 
If you are assigning the CarChip to a driver, the Drivers database table is displayed. Click 
on a driver record in the database table to highlight it, then click Select to assign the 
CarChip to the selected driver. 
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5. After selecting a vehicle or driver from their respective database tables, the CarChip 
dialog box is displayed. Click Yes to continue or click No to return to the database table and 
make another selection. 
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6. If the settings in the CarChip you are adding are different from the default CarChip 
settings in the database, The CarChip Default Settings dialog box is displayed. Click Yes to 
configure the CarChip with the default settings or click No to use the existing CarChip Settings. 
 

 
  
7. The Add CarChip Wizard - Safety Settings dialog box is displayed. This shows the 
CarChip's speed band, braking, and acceleration thresholds. 

 
  
8. When you are satisfied with the safety settings,  click on Next to continue or click Cancel 
to exit the Add CarChip Wizard. 
9. The Add CarChip Wizard - Parameters dialog box is displayed. This shows the engine 
and vehicle performance parameters that CarChip logs and the sample interval rates for each 
parameter.  
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10. When you are satisfied with the parameter settings,  click Next to continue or click 
Cancel to exit the Add CarChip Wizard. 
11. The Miscellaneous Settings dialog box is displayed. Enable or disable extra CarChip 
features, such as Alarm and LED Status using this dialog box. The Alarm feature only works with 
CarChip Fleet with Alarm (# 8245). Enabling this feature for a CarChip Fleet without alarm will not 
work. 
 

 
12. The Review Settings For New CarChip dialog box is displayed. This dialog box allows 
you to review the identification, safety, and parameter  and miscellaneous settings for the new 
CarChip one last time before you add it to the database.  
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13. When you are satisfied with the CarChip settings, click Set to add the CarChip to the 
database and to update the CarChip device settings. Select Cancel to exit the Add CarChip 
Wizard without adding the CarChip to the database or updating the CarChip device settings. 
14. When the CarChip has been successfully added to the database and the CarChip 
settings have been updated you will see the following Setup Result dialog box. 

 

15. Click OK to continue. 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

CarChip Settings 

Use the CarChip Settings command in the CarChip Menu to quickly view all CarChip settings, to 
add a CarChip to the database or to edit CarChip settings. 
 

1. Select CarChip Settings from the CarChip Menu. The CarChip Device Settings dialog box 
is displayed. 
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2. Make any desired changes. For more information on the CarChip settings, click on the 
links below: 

CarChip ID 
Hard Braking, Acceleration and Speed Bands 
Choose Parameters 
Miscellaneous Settings 

Note: If you change the vehicle assigned to a CarChip, the vehicle table will also be changed to 
reflect the new assignment. 

Note: If you assign a vehicle to a CarChip that had been previously assigned to a DriveRight 
device, the vehicle assignment for that DriveRight will be changed to "UNASSIGNED VEHICLE". 

3. If necessary, click Defaults to change the CarChip Hard Braking, Acceleration, Speed 
Bands, and Engine Parameters to the DriveRight FMS CarChip default settings. 
4. Click OK to save the changes or click Cancel to exit without saving. 
 
 
Back to  CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download CarChip 

Use this command to download data from your CarChip data logger into your computer. 
 
To download CarChip data: 

1. Connect your CarChip device to your computer. 
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2. Choose Download CarChip from the CarChip menu. The Downloading Data dialog box 
appears. 

 

2. The dialog box disappears when the download is complete. 
3. Choose Cancel only if you wish to abort the download before it is finished. 
 
See also: 
Downloading CarChip Guidelines 
 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Set Time and Date 

Use this command to set the time and date on a CarChip device. 
 
To set the time and date on a CarChip: 

1. Select Set Time and Date from the CarChip Menu. The Set Time and Date dialog box is 
displayed. The dialog box shows your computer's current time and date.  

 

2. Set the Date by either clicking the month, day or year in the edit box and entering the 
new information, or by clicking on the down arrow and selecting the date from the drop-down 
calendar. 
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3.  Set the time by clicking on the hour, minute or second in the edit box and entering the 
new time. You can also adjust the time settings up and down using the up and down arrows in the 
edit box. 
4. Click on Set to change the time and date on the CarChip device or click on Cancel to exit 
the dialog box without changing the settings. 
 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

LED Status 

Use the CarChip LED Status command to view or change the CarChip LED status configuration. 
 
To change the CarChip Status LED: 
 

1. Choose Set CarChip LED State in the CarChip Menu. The CarChip LED Status dialog 
box is displayed showing the current state. 

 

2. Click Enable if you wish to turn on the CarChip Status LED. 
3. Click Disable if you wish to turn off the CarChip Status LED. 
4. Click Set to configure the Status LED with the current setting or click Cancel to exit. 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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CarChip Alarm 

Use the CarChip Alarm command to view or change the CarChip Alarm status. 
 
To change the CarChip Alarm status: 
 

1. Select Set CarChip Alarm in the CarChip Menu. The CarChip Alarm dialog box is 
displayed showing the current state. 

 

2. Click Enable if you wish to turn on the CarChip Alarm. 
3. Click Disable if you wish to turn off the CarChip Alarm. 
4. Click Set to configure the alarm with the current setting or click Cancel to exit. 
Back to CarChip Menu 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Reset Check Engine Light 

Use the CarChip Reset Check Engine Light command to turn the CarChip Reset Check Engine 
Light feature on and off. Arming this feature resets the check engine light in the vehicle the 
CarChip is used in. Disarming this feature means that the CarChip does not reset the check 
engine light. 
 
To change the CarChip Reset Check Engine Light status: 
 

1. Select Reset Check Engine Light in the CarChip Menu. The dialog box is displayed 
showing the current state. 

 

2. Click Arm if you wish to turn on the CarChip Alarm. 
3. Click Disable if you wish to turn off the CarChip Alarm. 
4. Click Set to configure the alarm with the current setting or click Cancel to exit. 
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Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Display CarChip Memory 

Use this command to show memory usage by the CarChip device. 
 

1. Choose Display CarChip Memory from the CarChip menu. The CarChip Memory dialog 
box appears. 

 

2. Click OK to close the dialog box.  
o The amount of memory is displayed in kilobytes as well as the percentage of the 

available memory used. 
o "Used" shows the amount of memory occupied by data. 
o "Free" shows amount of memory available for new data. 
o "Total" shows the total amount of memory in the data logger. 

 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Show CarChip Info 

Use this command to show the firmware, bootware, and hardware version information for the 
currently connected CarChip device. 
 

1. Choose Show CarChip Info from the CarChip menu. The CarChip Identity Info dialog box 
appears. 
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2. Click OK to close the dialog box.  
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Clear CarChip Memory 

The Clear CarChip Memory command clears all trip data in the connected CarChip.  
 
To clear CarChip memory: 
 

1. Select Clear CarChip Memory in the CarChip Menu. The following CarChip dialog box is 
displayed: 

 

2. Click Yes to clear the CarChip device, click No to cancel the command. 
 
Back to CarChip Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Menu 

Use SmartCard Menu commands for functions dealing directly with the SmartCard device or the 
DriveRight devices in your fleet that are part of the SmartCard System..  
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Note: The SmartCard Reader must be connected and a valid SmartCard (meaning a card you 
wish to set up or an existing card you wish to download) must be connected to your computer to 
access Smart Menu commands. 

The following DriveRight Menu commands are available: 
SmartCard Download 
SmartCard Setup Card 
Transfer to DriveRight 
Clear Transfer Data 
SmartCard Erase 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Download 

The SmartCard Download command allows you to download data from a SmartCard containing 
data. To use this function: 

1. Insert the card you which to download into the Desktop Reader. 

Note: If you have not already done so, test the connection between the SmartCard Desktop 
Reader by using the SmartCard Reader command in the Setup Menu. 

2. Select Download from the SmartCard menu. The information in the card is automatically 
downloaded into the database for the assigned user and DriveRight, location, etc. 
 

 
 
During the download process, the software could display any of the following status messages or 
error messages. They include: 
  

• Data not properly downloaded from card. 

• Vehicle not assigned to the corresponding DriveRight device  
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• If device settings don't match with the settings in the database. 

• If the card is pulled out in the middle of downloading. 

Note: The FMS software always prompts the user to download trip data before it will allow other 
information to be transferred onto the card. This ensures that the trip data is safely logged in the 
database. Adding items to transfer back to the DriveRight will overwrite trip data. 

Once download is complete, the dialog box closes. 
 
Back to SmartCard Menu | Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Setup Card 

The Setup Card command in the SmartCard menu allows you to program new unused 
SmartCards  with Driver and DriveRight information.  
To setup a new SmartCard: 

1. Insert a new unused card into the Desktop reader. 
2. Select Setup Card from the SmartCard menu. The Setup Card dialog box is displayed. 

 

 
  

3. Select the Driver card radio button if this card will be assigned to an individual driver or 
select Fleet if this card controls settings for all of your fleet. 
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4. Select the driver name the card is assigned to, or select Unknown Driver (none) if all 
drivers in your fleet have privileges to the same card. If a starter interrupter is put in place 
with the SmartCard System, this means the user having the proper DriveRight ID 
assigned to the driver card will allow that driver to start the vehicle. 

5. Enter the Auto Logout Time for this card. This is the time span in which this card will 
automatically log itself out of a DriveRight System if the vehicle has not been started. 

6. Select up to 5 vehicles the assigned driver has access to using this card from the 
Vehicles in the Database combo box and click the >> button. The selected vehicles 
display in the Authorized Vehicles list. If you wish to take off a vehicle from the 
Authorized Vehicles list, select the vehicle name and click the << button.  

7. Click Set to program the new SmartCard with this information or click cancel to exit 
without saving the new information to the SmartCard. 

 
Back to SmartCard Menu | Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

SmartCard Transfer to DriveRight 

SmartCard Transfer to DriveRight 
Use the Transfer to DriveRight menu to assign a SmartCard information to transfer to a 
DriveRight device, such as driver identification, clock adjustment information, and driver lists. The 
commands available in the Transfer to DriveRight menu are: 
 
Settings 
Driver List 
Clock Adjustment 
 
Back to SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
Transfer to DriveRight Settings 

Transfer to DriveRight Settings 

Use the Transfer to DriveRight Settings command to edit and transfer settings to a selected 
DriveRight Device via the SmartCard system. 
To view or edit the DriveRight Settings that can be transferred to the DriveRight via the 
SmartCard:  

1. Select Transfer to DriveRight in the SmartCard Menu.  
2. Select Settings  from the list of commands. The Review Settings for SmartCard dialog 

box is displayed. 
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3. Select a tab to view or edit the following default settings: 
• Identification: Select the DriveRight ID and Driver associated with the card. 

• Calibration: Select calibration settings that the DriveRight device should use. 

• Unit Settings: Select the date, time and unit modes and click OK. 

• Safety Settings: Enter the speed, acceleration and deceleration limits and click 
OK. 

• Timer Settings:Enter the trip stop time and driver log out time and click OK. 

• Alarm Settings: Select the alarm mode. Warn if not logged in is an option. 

• Security Settings: Enter the security code (PIN code). Tamper indicator is an 
option.  

• GPS Settings: Turn the GPS logging and subsequent mapping feature on and off 
and select mapping features. Works only with DriveRight 600 units with GPS 
modules. 

4. When your are finished, click OK to save any changes or click Cancel to exit without 
saving changes. 
 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Identification Settings - SmartCard 

Use this command to identify the DriveRight device receiving the new settings from the 
SmartCard. The Identifcation settings control which DriveRight device gets the modifications 
assigned in the Review Settings for SmartCard dialog box. 
To select the identification settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
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2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. The Identification Tab is the default tab that is 
displayed upon opening the dialog box. 

 

3. Select the DriveRight device, ID, vehicle ID and default driver the device will be 
programmed to recieve. 
4. Click Set to save the Identification Settings, click Cancel to exit without saving the 
settings, or click on another tab to make additional changes to the DriveRight default settings. 
See also: 
Calibration Settings 
Unit Settings 
Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Calibration Settings - SmartCard 

Use this command to modify and edit the calibration settings for a specified DriveRight device. 
The calibration settings control how the DriveRight device is calibrated and monitoring the 
selected vehicle. 
To select the calibration settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
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2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed. 

3. Select the Calibration Settings tab near the top of the dialog box. The Calibration settings 
options are displayed. 

 

4. Describe the installation method or the type of connections/hookups used to connect the 
device to the vehicle in the Installation Method group box. 
5. Click Set to save the Calibration Settings, click Cancel to exit without saving the settings, 
or click on another tab to make additional changes to the DriveRight default settings. 
See also: 
Identification Settings 
Unit Settings 
Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Unit Settings - SmartCard 

Use this command to create default unit settings that can be used by all the vehicles in your fleet. 
 
To set default unit settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
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2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 
SmartCard dialog box is displayed.  

3. Select the Unit Settings tab near the top of the dialog box. 
 

 
  

4. Edit the unit settings for your fleet.  
o Date Mode settings control the way month, day, and year are displayed. 
o Time Mode settings control the time of day display. 
o Distance Unit settings allows you to select miles and miles per hour or kilometers 

and kilometers per hour as your speed and distance units. 
5. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
See also: 
Identification Settings 
Calibration Settings 
Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Safety Settings - SmartCard 

Use this command to create safety settings for the specified DriveRight. 
To set safety settings: 
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To select the identification settings: 
1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 

SmartCard dialog box is displayed.  
3. Select the Safety Tab near the top of the dialog box. 

 

4. Set the Speed Limit, which is the maximum allowable vehicle speed. 
5. Set the Accel Limit, which is the maximum allowable rate of acceleration. 
6. Set the Decel Limit, which is the maximum allowable rate of deceleration. 
7. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the settings. 
See Also: 
Identification Settings 
Calibration Settings 
Unit Settings 
Timer Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Timer Settings - SmartCard 
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Use this command to create timer settings used by the DriveRight devices controlled by the 
current smart card. 
 
To set timer settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 

SmartCard dialog box is displayed.  
3. Select the Timer Settings tab near the top of the dialog box. 

 

 
4. Set the trip stop time in minutes. The trip stop time is the number of minutes that elapse 

after a vehicle stops before the DriveRight stops recording trip data. 
5. Set the Driver ID Logout Time in minutes. Use a logout time of "0" to never log out the 

driver. The Driver ID Logout Time is the number of minutes that elapse after a vehicle 
stops before the driver is logged out of the DriveRight. 

6. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 

See Also: 
Identification Settings 
Calibration Settings 
Unit Settings 
Safety Settings 
Alarm Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Alarm Settings - SmartCard 

Use this command to create default alarm settings for a specified DriveRight device. The alarm 
settings control the audible alarms used to indicate when the safety settings thresholds are 
exceeded. 
To set default alarm settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 

SmartCard dialog box is displayed. 
3. Select the Alarm Settings tab near the top of the dialog box. The Alarm settings options 

are displayed. 

 

4. Set the Alarm Mode to On or Off. This controls audible alarm reporting by the DriveRight 
device. 
5. Enable "Warn if not Logged in" to have the DriveRight device give an audible alarm if the 
vehicle is operated without the driver first entering his or her driver code. 
6. Click Set to save the Alarm Settings, click Cancel to exit without saving the settings, or 
click on another tab to make additional changes to the DriveRight default settings. 
 
See also: 
Identification Settings 
Calibration Settings 
Unit Settings 
Safety Settings 
Timer Settings 
Security Settings 
GPS Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Security Settings - SmartCard 

Use this command to create security settings for the specified DriveRight. 
To set security settings: 
To select the identification settings: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 

SmartCard dialog box is displayed.  
3. Select the Security Settings Tab near the top of the dialog box. 

 

 
  

4. Set the Pin Code, which is required to set the calibration and alarm settings on the 
DriveRight device. 

5. If desired, you can enable the tamper indicator. If enabled, the tamper indicator on the 
DriveRight LCD screen will be displayed when a tamper event has been detected.  

6. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight settings. 

See Also: 
Identification Settings 
Calibration Settings 
Unit Settings 
Safety Settings 
Timer Settings 
Alarm Settings 
GPS Settings 
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Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

GPS Settings - SmartCard 

Use this command to view and edit the GPS settings that can be used by the specified vehicle. 

Note: Even if this feature is toggled on an off, it will only work with corresponding DriveRight 600 
units with GPS modules. 

To set  GPS logging settings: 
1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Settings from the Transfer to DriveRight submenu. The Review Settings for 

SmartCard dialog box is displayed. 
3. Select the GPS Settings tab near the top of the dialog box. The GPS settings options are 

displayed.  

 
4. Select On to turn the GPS logging feature on for all the units with a GPS module. Select 
Off to turn off the GPS feature for all DriveRight Devices. Select DriveRight Speed Only to log 
and track only the DriveRight Speed. This feature logs and tracks only the DriveRight speed for 
DriveRight 600 devices that are not assembled with a GPS module. 
5. If On or the DriveRight Speed only button has been selected, select the Logging interval 
time and corresponding time unit in the Log Data Every text field. The amount of logging hours 
this used for this feature are displayed in Logging Hours. 
6. Click Set to save the settings, click Cancel to exit without saving the settings, or click on 
another tab to make additional changes to the DriveRight default settings. 
See also: 
Identification Settings 
Calibration Settings 
Unit Settings 
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Safety Settings 
Timer Settings 
Alarm Settings 
Security Settings 
 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Drivers List 
The Drivers List dialog box allows you to set the user identifications assigned to the SmartCard 
currently inserted on the desktop reader.  

Note: The Drivers List dialog box should not be used in conjunction with DriveRight 500 devices. 
This feature is compatible with DriveRight 600 devices and allows you to select up to 100 drivers 
per device. 

To access the Drivers List: 
1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Drivers List from the Transfer to DriveRight submenu. The Set Drivers List dialog 

box is displayed. 
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3. Select the driver name/identification number the card is assigned to, and/or select 
Unknown Driver (none) if all drivers in your fleet have privileges to the same card, and 
click the >> button. The selected drivers display in the Drivers List (to set in SmartCard) 
combo box. If you wish to take off a driver from this list, select the driver name and click 
the << button.  

4. Click Set to SmartCard to program the new SmartCard with this information or click 
cancel to exit without saving the new information to the SmartCard. 

 
Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Clock Adjustment 
The Clock Adjustment  dialog box allows you to set control clock changes to the DriveRight using 
the SmartCard..  
To adjust the DriveRight clock: 

1. Select Transfer to DriveRight from the SmartCard Menu.  
2. Select Clock Adjustment from the Transfer to DriveRight submenu. The Clock 

Adjustment dialog box is displayed. 
 

 
  

3. Click the + Hour button set the DriveRight clock1 hour ahead, the - Hour set the clock 
back an hour. Use the Add and Subtract buttons to add or subtract a specified number of 
minutes from the DriveRight clock time. 

4. Click OK to save the new clock settings, or Cancel to exit the Clock Adjustment dialog 
box without saving. 

Back to Transfer to DriveRight | SmartCard Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Database Menu 

Database Menu 

Use the Database Menu options to open individual database tables. In the database table you 
can view and print records. You can also add, edit or delete records. 

Caution: Take extra care before deleting Company Location, DriveRight, CarChip, Driver or 
Vehicle records. 
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The following Database Menu options are available: 
 
Company Locations 
DriveRights 
CarChips  
Driver Groups 
Drivers 
Fleets 
Vehicles 
Trips 
Accident Logs 
Tamper Logs 
Trip Addresses 
Days 
Download Dates 
GPS 
Odometer Logs 
Safety Score 
Trouble Codes 
Readiness Codes 
 
Maintenance 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Company Locations 

Use this command to view and edit data for company locations. 
Caution: We strongly advise against changing a location name if you use FTP Export/FTP 
Import, since location name plays a very important role in these operations. If you do any 
kind of centralized data collection do not alter location name. 
 
To view or edit data for company locations: 

1. Select Company Locations from the Database menu. The Company Locations database 
table is displayed. 

2. Click the Add New button to add a new company location. 
3. Highlight a record in the database table and click Edit, or double-click a record to update 

the company location information. 
4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 
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See also: 
Add Company Location 
Update Company Location 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

DriveRights 

Use DriveRights to view or edit data for installed DriveRight devices. 

Note: You can only change the assigned vehicle when editing a DriveRight record. 

To view or edit DriveRight data: 
1. Select DriveRights in the Database menu. The DriveRights database table is displayed. 
2. Click the Add New button to add a new DriveRight to the database. This button starts the 

Add New DriveRight Wizard. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

information for a specific DriveRight device. 
4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Edit DriveRight Setup 
Print DriveRights 
Add New DriveRight Wizard 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

CarChips 

Use CarChips to view or edit data for installed CarChip devices. 

Note: You can only change the assigned vehicle or the assigned driver when editing a CarChip 
record in the database table. 

To view or edit CarChip data: 
1. Select CarChip from the Database menu. The CarChip database table is displayed. 
2. Click Add New to add a new CarChip to the database. This button starts the Add New 

CarChip Wizard. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

information for a specific CarChip device. 
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4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Edit CarChip Setup 
Add New CarChip 
 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Driver Groups 

Use Driver Groups in the Database menu to view or edit driver group data.  
 
To view or edit driver group data: 

1. Select Driver Groups in the Database menu. The Driver Groups database table is 
displayed. 

2. Click Add New to add a new driver group to the database. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

record. 
4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Add Drivers Group 
Edit Drivers Group 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Drivers 

Use Drivers in the Database menu to view or edit driver data.  
 
To view or edit driver data: 

1. Select Drivers in the Database menu. The Drivers database table is displayed. 
2. Click the Add New button to add a new driver to the database. 
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3. Highlight a record in the database table and click Edit, or double-click a record to edit the 
record. 

4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Add Driver 
Edit Driver 
Print Drivers 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Fleets 

Use Fleets from the Database menu to view or edit fleet data.  
 
To view or edit fleet data: 

1. Select Fleets from the Database menu. The Fleets database table is displayed. 
2. Click the Add New button to add a new fleet to the database. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

record. 
4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Add Fleets 
Edit Fleets 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Vehicles 

Use Vehicles from the Database menu to view or edit vehicle data.  
 
To view or edit vehicle data: 

1. Select Vehicles from the Database menu. The Vehicles database table is displayed. 
2. Click the Add New button to add a new vehicle to the database. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

record. 



DriveRight FMS Help 

119 

4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Add Vehicle 
Edit Vehicle 
Print Vehicles 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trips 

Use Trips from the Database menu to view, edit, or map trip data. 
To view or edit trip data:  

1. Select Trips from the Database menu. The Filter For Trips dialog box is displayed. 
2. Select your desired filter options.  
3. Click OK to show the Trips database table or click Cancel to exit the dialog box without 
opening the database table. 
4. Click Add New to create a new record. 
5. Click Set Filter to change the filter for the displayed records. 
6. Highlight a trip record and click Edit to view or edit that record in the Update window. 
7. Highlight a trip record and click Delete to delete the record. 
8. Click Close to exit the database table. 
9. Click Print to print the database table. 
10. Highlight a trip record then click Export GPS to export GPS data from that trip, or, press 
Control-D to export GPS data for the entire day of the currently selected record. 
11. Highlight a trip record then click Map to generate a Trip Mapping Report for that trip, or, 
press Control-D to generate a Day Mapping Report showing all trips taken the same day as the 
selected trip. 
 
See also: 
Filter for Trips 
Add Trip 
Edit Trip 
Print Trips 
Export: GPS to Mapping Software 
Trip Mapping Report 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Accident Logs 

Use the Accident Logs command in the Database menu to open the Accident Logs database 
table.  
 
To open the Accident Logs database table: 
 

1. Select the Accident Logs command in the Database menu. The Filter For Accident Logs 
dialog box is displayed. 

2. Select your desired filter options.  
3. Click OK to show the Accident Log database table or click Cancel to exit the dialog box 
without opening the database table. 
4. Click Set Filter to change the filter for the displayed accident logs. 
5. Highlight a specific accident record and click Edit to view that record in the Update 
Accident Log window. 
6. Highlight a specific accident record and click Delete to delete a specific accident log 
record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Tamper Logs 

Use Tamper Logs from the Database menu to view tamper log data. 
 
To view the Tamper Log data: 
 

1. Select Tamper Logs from the Database menu. The Filter For Tamper Logs dialog box is 
displayed. 

2. Select your desired filter options.  
3. Click OK to show the Tamper Logs database table or click Cancel to exit the dialog box 
without opening the database table. 
4. Click Set Filter to change the filter for the displayed records. 
5. Highlight a specific record and click Edit to view that record in the Update window. 

Note: You cannot edit tamper log data. 

6. Highlight a specific record and click Delete to delete that record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
 
See also: 
Filter for Tamper Logs 



DriveRight FMS Help 

121 

Edit Tamper Log 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trip Addresses 

Use Trip Addresses from the Database menu to view or edit trip address data.  
To view or edit trip address data: 

1. Select Trip Addresses from the Database menu. The Trip Addresses database table is 
displayed. 

2. Click the Add New button to add a new trip address to the database. 
3. Highlight a record in the database table and click Edit, or double-click a record to edit the 

record. 
4. Highlight a record in the database table and click Delete to delete that record. 
5. Click Close to exit the database table. 
6. Click Print to print the database table. 

 
See also: 
Add Trip Address 
Edit Trip Address 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Days 

Use Days in the Database menu to view or edit day data. Day data summarizes vehicle 
information by day. As the day data is composed from the trip database in the case of Trip 
Computer, Trip 500AL or DriveRight 600, you cannot add any data in this dialog box. While 
downloading data from a DriveRight, the day data will be processed and placed into the 
database.  
 
To view or edit the day data: 

1. Select Days in the Database menu. The Filter For Days dialog box is displayed. 
2. Select your desired filter options.  
3. Click OK to show the Days database table or click Cancel to exit the dialog box without 
opening the database table. 
4. Click Set Filter to change the filter for the displayed records. 
5. Highlight a specific record and click Edit to view that record in the Update window. 
6. Highlight a specific record and click Delete to delete that record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
9. Highlight a trip record then click Export GPS to export GPS data for trips taken on that 
day.  
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10. Highlight a trip record then click Map to create a Day Map for trips taken on that day.   
 
 
See also: 
Filter for Days 
Edit Days 
Print Days 
Export: GPS to Mapping Software 
Creating a Day Map 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Download Dates 

Use Download Dates in the Database menu to view or edit the download dates data.  
 
To view or edit the download dates data: 

1. Select Download Dates from the Database menu. The Filter For Download Dates dialog 
box is displayed. 

2. Select your desired filter options.  
3. Click OK to show the Download Dates browse window or click Cancel to exit the dialog 
box without opening the browse window. 
4. Click Add New to create a new record. 
5. Click Set Filter to change the filter for the displayed records. 
6. Highlight a specific record and click Edit to view that record in the Update window. 
7. Highlight a specific record and click Delete to delete that record. 
8. Click Close to exit the database table. 
9. Click Print to print the database table. 
 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

GPS 

Use GPS from the Database menu to view or edit GPS data.  
 
To view or edit GPS data: 

1. Select GPS from the Database menu. The Filter For GPS dialog box is displayed. 
2. Select your desired filter options.  
3. Click OK to show the GPS database table or click Cancel to exit the dialog box. 
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4. Click Set Filter to change the filter for the displayed records. 
5. Highlight a specific record and click Edit to view the selected record. 
6. Highlight a specific record and click Delete to delete that record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
 
See also: 
Filter for GPS 
Edit GPS 
Print GPS 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Odometer Logs 

Use the Odometer Logs command in the Database menu to view or edit odometer log data.  
 
To view or edit odometer log data: 

1. Select Odometer Logs from the Database menu. The Filter For Odometer Logs dialog 
box is displayed. 

2. Select your desired filter options.  
3. Click OK to show the Odometer Logs database table or click Cancel to exit the dialog 
box without opening the database table. 
4. Click Set Filter to change the filter for the displayed records. 
5. Highlight a specific record and click Edit to edit the selected record. 
6. Highlight a specific record and click Delete to delete that record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
 
See also: 
Filter for Odometer Logs 
Edit Odometer Log 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Safety Score 

Use Safety Score  from the Database menu to view Safety Score data or to edit a driver's 
exempt status for a given month.    
To display the Safety Score database table: 
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1. Select Safety Score in the Database menu. The Filter For Safety Score dialog box is 
displayed. 

2. Select your desired filter options.  
3. Click OK to show the Safety Score database table or click Cancel to exit the dialog box 
without opening the database table. 
4. Click Set Filter to change the filter for the displayed records. 
5. Highlight a specific record and click Edit to edit the selected record. 
6. Highlight a specific record and click Delete to delete that record. 
7. Click Close to exit the database table. 
8. Click Print to print the database table. 
 
See also: 
Filter For Safety Score 
Edit Safety Score 
 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Maintenance 

Use Maintenance sub-menu under the Database menu to perform data maintenance 
procedures, such as deleting records or batch editing records in the database.  

Select Delete Data from the Maintenance sub-menu to delete selected records for record 
types displayed in the drop down list. The record types for deletion are:  

o Trips 
o Accident Logs 
o Tamper Logs 
o Days 
o Download Dates 
o GPS 
o Odometer Logs 

Select Batch Editing from the Maintenance sub-menu to reassign certain database 
records to another driver or to re-calibrate speed readings for certain vehicles or drivers.  

 
Back to Database Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Reports Menu 

Reports Menu 

DriveRight can produce a number of useful reports. The reports can be displayed on the screen 
or printed. 
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The following reports are available: 
 
Accident Log Report 
Driver Safety Score 
Driver Safety Score Summary 
Exception Reports 
Database Reports 
Usage Report 
Trip Summary Report 
Tamper Logs Report 
Odometer Report 
Relationship Report 
Days Since Last Download 
 
 
Back to Menu Commands Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Accident Log Report 

The Accident Log report allows you to view, print, export or map the contents of the Accident Log.  
 
To create an Accident Log Report: 

1. Select Accident Log Report from the Reports Menu. The Accident Report dialog box is 
displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the DriveRight ID to be used in the report. 
4. Select the Start Date and the End Date for the accident logs to be listed in the report. 
5. Select the type of output for the report: Excel, Report Viewer, Map, or both Map and 
Excel. 
6. Click OK to create the report or click Cancel to exit the dialog box. 

See also: 

Mapping Quick Reference Menu 

Back to Reports Menu 

Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Driver Safety Score Report 

The Driver Safety Score report allows you to customize, view, print, email, or export the Driver 
Safety Score.  
 
To create the Driver Safety Score Report: 

1. Select Driver Safety Score Report from the Reports Menu. The Driver Safety Score 
dialog box is displayed. 
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2. Click on the company locations to be used in the report. The selected locations are 
highlighted. 
3. Select the Start Date and the End Date for the driver safety data to be included in the 
report. 
4. Use the "Compare with last ___ months" text box to enter the number of months back 
from the start date that you want to include in the calculation of the "cumulative" score.  The 
cumulative score will be calculated from the start date minus X months up to and including the 
end date. 
5. Use the Sort by options to sort the output by current score, cumulative score, or the 
driver's name.  If you sort by current score and choose "Use Color", the coloring is done based on 
the current score.  If you sort by cumulative score, the coloring is done based on cumulative 
score.  If you sort by driver's name, coloring is done based on the current score. 
6. Select the type of output for the report: Excel, Report Viewer, or Email. Click Use Color to 
enable color printing. 
7. Check Group By Location to group together the scores for each location. Check Drivers 
With Mileage Only to display only drivers with trips/mileage listed to their identification. Check 
Corporate Report to generate the Driver Safety Score Report based on the corporate hierarchy 
structure created in the Corporate Structure dialog box.  
8. Click on the Formula button to view or change the Driver Safety Score parameters. 
9. Click OK to create the report or click Cancel to exit the dialog box. 
 
See also: 
Driver Safety Score Formula 
Output to Excel 
Output to Email 
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Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Driver Safety Score Summary Report 

The Driver Safety Score Summary command creates a Driver Safety Score Summary Report 
based on the Safety Score Reports stored in the Safety Score Table.  
 
To create the Driver Safety Score Summary Report: 

1. Select Driver Safety Score Summary Report from the Reports Menu. The Driver Safety 
Score Summary dialog box is displayed. 

 

2. Click on the company locations to be used in the report. The selected locations are 
highlighted. 
3. Select the Duration of the report. This is the number of months to be included in the 
report. 
4. Select the End Date for the report. FMS will calculate the Start Date based on the 
Duration and End Date. 
5. Use the Sort by options to sort the output by current score, report average, or the driver's 
name.  If you sort by current score and choose "Use Color", the coloring is done based on the 
current score.  If you sort by report average, the coloring is done based on report average score. 
 If you sort by driver's name, coloring is done based on the current score. 
6. Select the type of output for the report: Excel, Report Viewer, or Email. Click Use Color to 
enable color printing. 
7. Check "Group By Location" to group together the scores for each location. 
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8. Check "Recalc data for all months" to have the monthly scores recalculated for this 
report. 
9. Click on the Formula button to view or change the Driver Safety Score parameters. 
10. Click OK to create the report or click Cancel to exit the dialog box. 
 
See also: 
Driver Safety Score Formula 
Output to Excel 
Output to Email 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Exception Reports 

Exception Reports 
Exception Reports can be printed for Vehicles, Drivers, and Trip Addresses. 
 
Excessive Speed Report 
Night Driving Report 
Hard Braking Report 
Time Over Speed 
 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Excessive Speed Report 
Use the Excessive Speed Report to identify drivers that exceed a set speed. 
 
To create an Excessive Speed Report: 
 

1. Select Excessive Speed Report from the Exception Reports command in the Reports 
Menu. The Excessive Speed Report dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sort By criteria by clicking next to either Driver Name or Date. 
4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
5. If you are creating the report for specific drivers, select the driver's name in the list.  

o Click once to select the name and click a second time to clear the name.  
o Multiple drivers can be selected for the report. 

6. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
7. Select Trips Between to create a report that only lists trips taken between specific dates. 
If you select Trips Between, then indicate the Start Date and End Date for the reported trips. 
8. Enter the Top Speed in the edit box. Trips with speeds in excess of the top speed will be 
listed in the report. 
9. Click OK to create the report or click Cancel to exit the dialog box. 
10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu | Exception Reports 
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Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Night Driving Report 
Use the Night Driving Report to list trips that occur during user-defined nighttime hours. Use this 
report to track unauthorized night driving.  
 
To create a Night Driving Report: 
 

1. Select Night Driving from the Exception Reports command in the Reports Menu. The 
Night Driving Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sorting criteria by clicking next to either Driver Name or Date. 
4. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
5. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
6. If you are creating the report for specific drivers, click on the drivers name in the list.  

o Click once to select the name and click a second time to clear the name.  
o Multiple drivers can be selected for the report. 

6. In the Define Night box enter the night times for the report. Night will begin at the After 
time. Night will end at the Before time. 
7. In the Choose Limit box you can configure the report to list trips with at least the minimum 
amount of night driving time that you specify for a single trip, or you can choose to list trips for 
drivers with at least the minimum amount of total night driving time during the chosen date 
interval.  
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8. In the Choose Interval box you can set start and end dates for the trips to be included in 
the report. 
9. Click OK to create the report or click Cancel to exit the dialog box. 
10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu | Exception Reports 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Hard Braking Report 
Use the Hard Braking Report to identify drivers that use the brakes excessively. 
 
To create a Hard Braking Report: 
 

1. Select Hard Braking from the Exception Reports command in the Reports Menu. The 
Hard Braking Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sort By criteria from the drop-down list: Driver name, Date, Decel count and 
Decel count rate. 
4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
5. If you selected Driver Names, click on the names of drivers to be included in the report. 
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o Click once to select the name. You can click a second time to clear the name.  
o Multiple drivers can be selected for the report. 

6. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
7. In the Choose Limit box you can configure the report to include all trips with at least the 
indicated number of deceleration counts or you can include the trips for all drivers that exceed the 
minimum number of deceleration counts during the chosen date interval. 
8. In the Choose Interval box you can set start and end dates for the trips to be included in 
the report. 
9. Click OK to create the report or click Cancel to exit the dialog box. 
10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu | Exception Reports 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Time Over Speed 
Use the Time Over Speed Report to identify drivers that speed excessively. 
 
To create a Time Over Speed Report: 
 

1. Select Time Over Speed from the Exception Reports command in the Reports Menu. The 
Time Over Speed Report dialog box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sort By criteria from the drop-down list: Driver name, Date, Time over speed 
and % of time over speed.. 
4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
5. If you selected Driver Names, click on the names of drivers to be included in the report. 

o Click once to select the name. You can click a second time to clear the name.  
o Multiple drivers can be selected for the report. 

6. In the Choose Interval box you can set start and end dates for the trips to be included in 
the report. 
7. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
8. In the Choose Limit box you can configure the report to include all single trips with at 
least the amount of time over the speed limit or you can configure the report to show total time 
over the speed limit.. 
9. Click OK to create the report or click Cancel to exit the dialog box. 
10. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu | Exception Reports 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 



DriveRight FMS Help 

135 

 

Database Reports 

Database Reports 
Database Reports can be printed for Vehicles, Drivers, and Trip Addresses. 
 
Vehicles Report 
Trip Addresses Report 
Drivers Report 
 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Vehicles Report 
To print a Vehicles Report: 

1. Select Vehicles Report from the Database command in the Reports Menu. The Vehicles 
Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sorting criteria by clicking next to the desired parameter. 
4. Select View for to display vehicles from a specific fleet or of a specific type. 
5. Click OK to create the report or click Cancel to exit the dialog box. 
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6. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu | Database Reports 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Trip Addresses Report 
The Trip Addressees Report displays a list of the trip addresses in your database. 
 
To view the Trip Addresses Report: 
 

1. Select Trip Addresses Report from the Database command in the Reports Menu. The 
Trip Addresses Report is displayed. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
Drivers Report 
To print a Drivers Report: 

1. Select Drivers Report from the Database command in the Reports Menu. The Drivers 
Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
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3. Select the Sorting criteria by clicking next to the desired parameter. 
4. Select View by to display drivers from a specific group. 
5. Click OK to create the report or click Cancel to exit the dialog box. 
8. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
Back to Reports Menu | Database Reports 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Usage Report 

The Usage Report provides a quick and easy-to-read summary of driver or vehicle mileage. 
 
To create a Usage Report: 

1. Select Usage Report from the Reports Menu. The Usage Report dialog box is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sorting criteria from the drop-down list. 
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4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
5. If you are creating a report for specific drivers, click on the drivers name in the list.  

o Click once to select the driver and click a second time to de-select the driver.  
o Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 
7. If you are creating a report for specific vehicles, click on the vehicles ID in the list.  

o Click once to select the vehicle and click a second time to de-select the vehicle.  
o Multiple vehicles can be selected for the report. 

9. Check "Show Mileage By Trip Type" to include a breakdown of the trip mileage by type of 
trip. DriveRight supports the following trip types: business, personal, commute and other. 
10. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 
11. Select the type of output for the report: Excel, Report Viewer, or Email. 
12. Click on the Formula button to set or change the time definitions for night and weekend 
driving.  
13. Click OK to create the report or click Cancel to exit the dialog box. 
 
See also: 
Usage Report Formula 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Trip Summary Report 

The Trip Summary Report provides a quick and easy-to-read summary of trips taken by either 
drivers or vehicles. The report also calculates the total trip time and distance for each driver. 
 
To create a Trip Summary Report: 

1. Select Trip Summary Report from the Reports Menu. The Trip Summary Report dialog 
box is displayed. 
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2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sorting criteria from the drop-down list. 
4. Select All Drivers to print the report for all drivers, or select Driver Names to create the 
report for specific drivers. 
5. If you are creating a report for specific drivers, click on the drivers name in the list.  

o Click once to select the drive and click a second time to de-select the driver.  
o Multiple drivers can be selected for the report. 

6. Select All Vehicles to print the report for all vehicles, or select Veh ID/ Lic. No to create 
the report for specific vehicles. 
7. If you are creating a report for specific vehicles, click on the vehicles ID in the list.  

o Click once to select the vehicle and click a second time to de-select the vehicle.  
o Multiple vehicles can be selected for the report. 

9. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
10. To specify a start date and end date for the report, check Trips Between and then enter 
the starting and ending dates. 
11. Click OK to create the report or click Cancel to exit the dialog box. 
12. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
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Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Tamper Logs Report 

The Tamper Logs Report allows you to view the tamper logs for the selected drivers. The report 
is displayed by the DriveRight FMS Report Viewer. 
 
To view the Tamper Logs Report: 
 

1. Select Tamper Logs Report from the Reports Menu. The Tamper Logs Report dialog box 
is displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Select the Sort by criteria by clicking next to either Driver Name or Date. 
4. Check "Show Most Recent Dates First" to list trips from the most recent trip to the oldest. 
If this box isn't checked the trips will be listed from the oldest trip to the most recent. 
5. Check All Drivers to create an Tamper Logs Report for all drivers in the database.  
6. Check Driver Names to create an Tamper Logs Report for specific drivers in the 
database. 
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7. If you are creating the report for specific drivers, select the driver name from the list.  
o Click once to select a driver. Click a second time to de-select.  
o Multiple drivers can be selected for the report. 

8. Select Tamper Logs Between to create a report that only lists Tamper Logs recorded 
between specific dates. If you select Tamper Logs Between, then indicate the Start Date and End 
Date for the report. 
9. Enter the maximum allowable time between unplugging the DriveRight and downloading. 
The report will include all include all times the limit was exceeded. 
10. Enter the maximum allowable time between downloading the DriveRight and 
reconnecting to the vehicle. The report will include all include all times the limit was exceeded. 
11. Click OK to create the report or click Cancel to exit the dialog box. 
12. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Relationship Report 

The Relationship Report displays the vehicle and default driver assigned to each of the 
DriveRight devices in your database. 
 
To view the Relationship Report: 
 

1. Select Relationship Report from the Reports Menu. The report is displayed using the 
DriveRight FMS Report Viewer. 

2. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Odometer Report 

The Odometer Report allows you to view the odometer reading for vehicles in the database, as 
well as the number of days since the last download for that vehicle and the date the last odometer 
adjustment was made. A report option allows you to included the default driver for each vehicle 
listed in the report. 
 
To view the Odometer Report: 
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1. Select Odometer Report from the Reports Menu. The Odometer Report dialog box is 
displayed. 

 

2. Verify the Company Location. Use the Current Location command in the Setup Menu to 
change the location if necessary. 
3. Check All Vehicles to create an Odometer Report for all vehicles in the database.  
4. Check Veh ID/Lic. No to create an Odometer Report for specific vehicles in the database. 
5. If you are creating the report for specific vehicles, select the vehicle's ID from the list.  

o Click once to select the vehicle and click a second time to clear the vehicle.  
o Multiple vehicles can be selected for the report. 

6. Select the Sort By criteria from the drop-down list: Vehicle ID, License and Odometer. 
7. Check Show Default Driver if you want the name of the default driver for each vehicle 
included in the report. 
8. Click OK to create the report or click Cancel to exit the dialog box. 

o If you click OK, the report is displayed using the Report Viewer.  
o You can print the report using the Print command in the File Menu. 

9. You can clear the report using the Clear Screen command in the File Menu or by clicking 

on the Clear Screen icon: . 
 
 
Back to Reports Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Mapping Menu 
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Mapping Menu 

Note: DriveRight FMS Mapping requires Microsoft MapPoint.  

The following commands are available in the Mapping Menu: 
 
Open Map 
Save Map 
E-Mail Map 
MapPoint Version 
Set Speed Range 
 
 
See also: 
Mapping Quick Reference Menu 
DriveRight FMS Mapping Requirements 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Open Map 

Use the Open Map command to view a previously saved DriveRight GPS map.  
 
To open a map: 
 

1. Select the Open Map command in the Mapping menu. The Open dialog box is displayed. 

 

2. Click the map file you wish to view and then click Open, or just double-click the file to 
open it. The map is opened in the FMS window. 
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3. Click the Clear Screen Icon  to remove the map from the FMS window, or use the 
File Menu Clear Screen command. 
 
See Also: 
Viewing Maps 
 
 
 
Back to  Mapping Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Save Map 

Use the Save Map command to save a DriveRight GPS map.  
 
To save a map: 
 

1. Select the Save Map command in the Mapping menu. The Save As dialog box is 
displayed. 

 

2. Enter the file name for the map file then click Save to save the map or click Cancel to exit 
the dialog box without saving the map.  

Note: The Maps directory is located in the DriveRight FMS program folder. 

 
See Also: 
 
Mapping GPS Data in DriveRight FMS 
Viewing a Map 
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Back to  Mapping Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

E-Mail Map 

Use the E-Mail Map command to e-mail a DriveRight GPS map.  

Note: DriveRight FMS can only e-mail the map currently displayed in the program window. 
Requires MS Outlook. 

To e-mail a map: 
 

1. Select the E-Mail  Map command in the Mapping menu. DriveRight FMS opens a new 
mail message window in MS Outlook with the map included as an attachment. 

2. Address the message and edit the subject and content as you desire.  
3. Click Send to send the message or close the message window to cancel the e-mail . 

 
See also: 
Viewing Maps 
 
Back to  Mapping Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

MapPoint Version 

Use the MapPoint Version command to select either MapPoint North American or MapPoint 
Europe. 
 
To select your MapPoint version: 
 

1. Click on the MapPoint Version command in the Mapping menu. The MapPoint dialog box 
is displayed. 

 

2. Click on the MapPoint version you are using to select it. 
3. Click OK to change the MapPoint version or click Cancel to exit the dialog box without 
changing the MapPoint version. 
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Back to  Mapping Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 
 

Set Speed Ranges 

You set up to 8 speed ranges to identify vehicle speed in DriveRight FMS mapping reports.  
 
To set the speed ranges: 
 

1. Click Set Speed Ranges command in the Mapping menu. The Set Speed Ranges dialog 
box is displayed. 

 

2. Select the number of speed ranges to be used in mapping reports. Each range will be 
represented by a push-pin of the indicated color when a map is created. 
3. Edit the "To" column to adjust the speeds indicated for each range. 
4. Click OK to save the changes or click Cancel to exit without saving the changes. 
 
See also: 
Mapping Overview 
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Back to  Mapping Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Help Menu 

The following commands are available in the Help Menu: 
 

• Help Topics 
Opens the Help Topics window showing the Contents, Index, and Search options. 

 

• About DriveRight FMS 3.4 
Displays the program version information, the release date, and the copyright 
information. 

 
 
Back to Menu Commands 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Troubleshooting 

Troubleshooting Menu 

If you encounter problems installing or using DriveRight FMS, please contact Davis Instruments 
Technical Support. 

Note: If you encounter any type of problems, the errors are logged in the log file eventLog.txt, 
present in DriveRight FMS install directory. 

 
The following DriveRight FMS troubleshooting help is available: 
 
Device Communication Problems 
Database Connection Problems 
Miscellaneous Problems 
Contacting Davis Instruments 
 
 
Back to Home 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
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Device Communication Problems 

Take the following steps if the software does not communicate with a DriveRight or CarChip 
device: 
 

1. DriveRight devices only - Check to make sure the  DriveRight console is in the 
CURRENT mode instead of in sleep mode. If the LCD screen is blank, the console is in 
sleep mode. Press the MODE key to put the console in active mode..  

2. Check that the correct Serial Port is selected.  
3. If you have other programs running which use the serial port, such as the Palm HotSync 

Manager and the CarChip software, close those programs and try again. 
4. Check if the hardware is ok and that you have a working communication port. If 

necessary, contact your PC supplier. 
 
See also: 
Communications Port - DriveRight 
Communications Port - CarChip 
 
 
Back to Troubleshooting Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 
 

Database Connection Problems 

Since DriveRight FMS supports multiple database systems, things could go wrong during 
database connection due to various reasons. 
 

Database Setup Error 

Refer to the instructions in the message box if you get the following error message: 

 

Database Not Setup Properly 
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Refer to the instructions below if you get the following error message: 

 

o If you are using MS Access: The database does not exist at the specified location. 
o If you are using any other database: Either the database server is not running, or you do 

not have enough permissions to connect. Please refer to database configuration in the 
DriveRight FMS Database Selection Guide. 

 
 
Back to Troubleshooting Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Software Problems 

To be provided. 
 
 
Back to Troubleshooting Menu 
 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 

Miscellaneous Problems 

If you selected the wrong database type during the initial program configuration, you can 
manually reset the database type in the config.txt file and then start over all again.  

1. If DriveRight FMS is open, close it. 
2. First locate the configuration file config.txt present in DriveRight FMS install directory. 
3. Open the file (it should come up in MS Notepad), and you’ll see the following text near 

the beginning of the file: 
 

############################################## 
# this variable represents the database type  
# used to store the data 
# 0- represents Database connection is not yet configured 
# 1- represents MS Access 
# 2- represents MySQL 
# 3- represents Oracle 
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# 4- represents MSDE/MS SQL 
############################################## 

DATABASE_TYPE=2 
 

4. Edit the last line, and replace the number by 0 (zero, not capital O). After you edit the 
variable, the text in the file looks like this: 

DATABASE_TYPE=0 
 

5. Save the file and close MS Notepad. 
6. Run DriveRight FMS again and you will prompted to select the database type. If you 
need assistance, refer to the database installation instructions in the DriveRight FMS Database 
Selection Guide. 
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Contacting Davis Instruments 

You may contact Davis Instruments for technical support or product information using any of the 
methods shown below. 

Technical Support 

Our Technical Support Team is available Monday through Friday, 7:00 a.m. to 5:30 p.m. Pacific 
Time. Or use our website, fax, fax-back, or e-mail any time day or night. 
Phone Technical Support: 510-732-7814  
Fax Technical Support: 510-670-0589  
E-Mail Technical Support 
Automotive Support Web Site  
The Automotive Support section of our web site is your source for DriveRight FAQs, instruction 
manuals, software downloads, and spec sheets. 

Other Ways to Contact Davis Instruments 

Sales (US & Canada): 800-678-3669  
Sales (Outside the US & Canada): 510-732-9229  
Fax: 510-670-0589  
E-Mail to our Customer Service Department: sales@davisnet.com  
E-Mail comments or general information to info@davisnet.com  
Davis Instruments Web Site 
Visit the Davis instruments web site to find additional products  
Back to Menu Commands | Troubleshooting Menu 
Home | Getting Started | Quick Reference | Menu Commands | Troubleshooting 


